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This documentation contains proprietary information of Objet Ltd. This information is supplied solely
to assist authorized users of Objet500 - Connex 3 3-D printing systems. No part of this document may
be used for other purposes, and it may not be disclosed to other parties.

The specifications on which this document is based are subject to change without notice.

No part of this book may be reproduced in any form or by any means, nor stored in a database or
retrieval system, without prior permission in writing from Objet Ltd.

If this document is distributed as a PDF file, you may print it for internal use.

The following are registered trademarks of Objet Ltd.: Objet®, FullCure®,
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All names of products and services cited in this book are trademarks or registered trademarks of their
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The equipment referred to in this guide has been tested and found to comply with the limits for a
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. Objet 3-D
printing systems generate, use and can radiate radio-frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference, in which case
the user will be required to correct the interference at his own expense.

The 3-D printer referred to in this guide contains a transmitter module, FCC ID YH6-MATCAB.

NOTE: Objet is not responsible for radio or TV interference caused by unauthorized modification to
this equipment. Such modification could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it
must be sent to appropriate facilities for recovery and recycling. For information about proper
disposal, check your purchase contract, or contact the supplier of the equipment.
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The product, software or services are being provided on an “as is” and “as available” basis. Except as
may be stated specifically in your contract, Objet Ltd. expressly disclaims all warranties of any kind,
whether express or implied, including, but not limited to, any implied warranties of merchantability,
fitness for a particular purpose and non-infringement.

You understand and agree that Objet Ltd. shall not be liable for any direct, indirect, incidental, special,
consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Objet has been advised of the possibility of such
damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of
procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software
or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product,
software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they
are based are subject to change. Objet Ltd. may, at any time and without notice, make changes to this
document. Objet Ltd., for itself and on behalf of its subsidiaries, assumes no liability for technical or
editorial errors or omissions made herein, and shall not be liable for incidental, consequential, indirect,
or special damages, including, without limitation, loss of use, loss or alteration of data, delays, or lost
profits or savings arising from the use of this document.



Patents

This product is covered by one or more of the following U.S. patents:
5,386,500
6,259,962
6,569,373
6,658,314
6,850,334
7,183,335
7,209,797
7,225,045
7,364,686
7,369,915
7,479,510
7,500,846
7,604,768
7,628,857
7,658,976
7,725,209

Objet Ltd.
http://www.objet.com

DOC-07000
Revision Rev. A
October 2012

g3



contents

1 About This Guide

USING This GUIAE .......cuiiiiiiiiiiciiiicc s 1-2
FOr MoTe INOrMAatioN......c.ccoiuiuiuiiiiiciiiicicceeeeeiete et nenne 1-2
Terms Used in This GUIde.......cccccciiiiniiiiiiiiiiiiiii e 1-3
2 Safety
Safety FEALUTES ......cvueiiiiiii s 2-2
Symbols and Warning Labels ... 2-3
Safety GUIAELNES .......ccoviiiiii s 24
Printer INStallation .........cccoviiiiiiininiiiiii s 24
Printer OPeration ..o e 24
UV RAIAION ..o 24
Printer MaiNteNanCe ...........cocciiiiiiiiiicciccc s 24
Model and Support Materials ... s 2-5
First Aid for Working with Printing Materials...........cccccocoiiiiiiiiiiiiis 2-6
Contact With SKiN......cooiiiiiiiiiiiii s 2-6
Contact With EYeS ......ccccoiiiiiiiiiiiiiiiiic e 2-6
INGESION ...t s 2-6
INNALALION oot 2-6
Waste DISPosal.......ccciiiiiiiiiiii s 2-7

3 Introducing the Objet 3-D Printing System

WOTK ConfigUurations.........cccccucuiuiiiiiiiiiiiiiiiiceicecece e 3-2
SOUTCE FIlES ...ttt 34
STL FALES ...ttt 34
SLC FILES ...ttt e 34
Printing Materials .........ccccociiiiiiiiiiiiiiii s 34
Available Materials..........cccoiiiiiiiiiiiiii s 3-5
SEOTAGE co.veeit et 3-6
SHEIE LIfe....oviiiiiiciciiic s 3-6
EXPOSUIe t0 Light.....cocooiviiiiiiiiiiiiiiiiiici e 3-6
Safety CONSIAETations.........cccccciiiiriiiiiiiiiiiiiiiiic e 3-6
DISPOSAL ...t 3-6
WOrk ENVIFONMENt .....cooviiiiiiiiieiittctccic s 3-7
Workstation ReqUITements..........cccviiiiininiiiiniiii e 3-8
Preparing Files for Use with Objet 3-D Printing Systems........c.cccccceeueueieueneneeieeeeeiceeeeene 3-9
Converting CAD Files to STL FOrmat..........cooouoiiiiiiieieeecccce s 3-9
Converting Files t0 SLC FOIMALt .........ccooviumiiiiiiiiiccceie s s 3-9
Objet StUAIo SOFEWATE ..o 3-10

4 Installing Objet Software
How to Install Software for the Objet 3-D Printing System ...........ccccooeueioiiiiiiicnniicceeene, 4-2

DOC-07000 Rev. A



Objet500 - Connex 3 User Guide

5

vi

Using Objet Studio
Objet Studio INterface........ccvuiviiiiiiiiiiiiiici s 5-3
Ribbon Commands...........cccviiiiiiiiii 5-5
Objet Studio Commands MENU..........ccceviiiiiininiiiii e 5-7
MOdel TTEE PANE........vieiecieieiiiiicii ettt 5-7
Preparing Models for Production.........ccccccccciciiiiiiciiicceeccceeeteeeieeeeeeeeeeeeeeeeeeeeeee e 5-8
OBJDF FILES: OVEIVIEW ...ccuvivieeieniiieetteiesteseeiesie st etesaesteeseesaessesseessessesseessessassesssessessessesssessessessenssans 5-8
MOAEL FIIES ...ttt 5-8
Placing Objects on the Build Tray .......cccooooeiieieiiieiicicee e 5-8
Opening Objet Tray Files...........cooiriiiiiiiiccie ettt 5-12
Quick-Access Model COMMANAS ......ccveieriirieieierieeeeierteseeteste e et e stesteeseeaessessesseessessesssessensenss 5-14
Copying and Pasting ObJECtS...........cccvurueiiieiiirieiieiicect s 5-15
SeleCting ODJECES .....ucueviiceiiicieteict ettt 5-16
Surface FINISH ..o e 5-16
Positioning Objects on the Build Tray ........ccccccvviviiiiiniiiniiiiiiiiiiicnas 5-17
Automatic Orientation ... s 5-17
Automatic Placement ... 5-18
Manual POSIHONING ......ccoiviiiiiiiiiiiic s 5-19
Model Orientation.........cciiiviiiiimiiiiiiiici s 5-20
Manipulating Objects on the Build Tray ..o 5-21
Positioning Objects 0N the Z-AXIS.......ccccciiiiniiiiiiiiiiiiic e 5-21
Valid Object PIaCEMENL .........ccoiriiiiiiiiiiiiiiiiiccc s s 5-22
Using a Grid to Position ODJects ... 5-23
Measurement UNItS ... 5-24
Setting Model DimenSions ............c.ouovoieiciiiiieieieeccci s 5-25
Repositioning ODJECtS ........coeueioiiiiiieiee et 5-25
Changing an Object’s OTientation.........cccooeeveirieiiciniiiece s 5-27
Freezing Model Orientation..........c..ovueviciiieiiicieiicic e 5-28
DiSPlay OPtionsS.......cccuiuiiiiiiiiiiiiiii s 5-29
VIEWING ODJECES ..ottt 5-29
SCIEEN LAY OUL ....oovvitctciceii e 5-31
TTaY PeISPECHIVE .ottt 5-32
Setting Object COlOTS. ..o 5-33
Loading Large Files........cccciiiiiiiiiiicccc e 5-34
Large File Manipulation ..........ccccccciiiiininiiiiiiiiiiiicccc e 5-34
ZOOIMN OPHIONIS ...ttt s 5-36
Handling Completed TTrays........ccccviiiiniiiiiiiiic s 5-37
Tray ValidAtion .....c.ccuiiiiiiiciciciiccce ettt 5-37
Production ESHMALES .......c.cciiiiiiiiiiiiiiciiiic s 5-38
E-mailing Objet Digital Files..........cccoooiiiiiiiiiiiicciciee e 5-38
Printing the Tray File ..ottt 5-38
Applying Additional Objet Studio Features...........ccccoceeuiivriviniiiinnnninnrcnrreeercaes 5-40
Dividing ODJECtS .....vviieiiicieicct e 5-40
Choosing the SUpport Strengthi ..o 5-41
“Hollow” — Filling Models with Support Material..........cccccccevvniiiiiinien, 5-42
Displaying the Cross Section of ObJECtS...........ccovviiiiiiiiiiiiiiiiii e 543
Saving the Screen Display as an Image File .........ccccocovviinnie, 5-44
Exporting and Importing Objet Build Trays ........ccccevviviniiiiiiiiiiiccnces 5-45
Customizing Objet StUAI0.......ccoviiiiiiii e 5-46
Creating a Quick Access TOOIDAT .........couviiiiiiiiiiiiiiiiiic e 5-46
Hiding the RIDDOM ... 5-47
DISPIAY COLOTS......ciiiiiiiiiiiric st 5-48
Keyboard ShOrtCULS..........cociviiic e 5-49
Setting User PTeferences. ..ottt 5-50
Professional Mode FEatUres ..o s 5-51
Default SEHNGS .....cvvviieiiieciici e 5-52
Open GL Driver COnfiguration .........cooeoeeueiieinieiniiciicieccieeese et 5-53



User Guide

Getting Additional Objet Studio AsSiStance...........c.ccovviviiiininininini 5-55
Monitoring and Managing Print Jobs ... 5-56
JOb Manager SCIEETN ..........cvvviiiiiiiiiii e 5-56
Setting the Printer CONNECHON ..........cciiiiiiiiiiiiiiiii s 5-58
Off-lINE MOAE ... s 5-59
Setting the Remote Printer Connection (Client Mode)..........cccoouvuiiiiiinnninniiccciiicen 5-61
Job Manager COmMMANAS ........c.ccceeuiiiiininiiiici e 5-61
Configuring USer ALETES........ccviuiviieiiiiicieiicic s 5-64
Printing the TTay ......ccociiiiiiiccccc e 5-65
Additional Server Features.........ccooviiiiiiiniiiiiiiicci e 5-65

6 Operating & Maintaining the Objet30 3D Printer

Starting the Objet30 Printer ... 6-2
Loading Model and Support Cartridges ...........ccccceeiiiiiiiiiiiniiiiiiiiiicnnes 6-4
Producing Models..........ccoiiiiiiiiiiii s 6-6
Printer Interface Color KeY.........ccoviiiiiiiiiiiiiiiiiis s 6-8
Printing INAiCators ........ccviiiiiiiiiiiii s 6-9
Resuming Production After Printing has Stopped ... 6-10
Changing the Model Material...........cccocoviviiiiiiiii s 6-12
Keeping the Printer in Idle Mode.........ccccoviiiiiiicns 6-16
Shutting Down the Printer ... 6-17
Shutdown WiIZard..........coeviiiiiiiiiiic s 6-17
Material FIush/Fill Wizard .........ccccccoiiiiiiiiiiiiiccc s 6-19
Maintaining the Printer..........cooiiiiii s 6-22
Routine Maintenance Schedule..............ccooiiiiiiiii s 6-22
Cleaning the Print Heads...........ccooviiiiiiicc s 6-23
Pattern TeSt ..o s 6-25
Improving Print QUality ... 6-26
Cleaning and Replacing the WIPer ..o 626
Cleaning and Replacing the Roller Waste Collector...........ccovveuiirreriinieicciniceecenes 6-30
Aligning the Print Heads ..o 6-32
Calibrating the Load Cells ... s 6-36
Replacing the Odor FIIter ... 6-38
Replacing the UV Lamp ... 6-39
Replacing the Waste Container............ccccciiiiviniiiiiiiiiiiiiiiccc e 6-44
Cleaning the EXterior Panels ... 6-46
Backing-Up and Restoring Printer Settings ..o 6-47
Relnitiate WIzard ..o s 6—47

7 Handling Printed Models

Removing Models After Printing ... 7-2
Removing the Support Material ..........cccccoiiiiiiiiiiiiiiiiis 7-2
Post-Printing Treatment for Models Printed with Objet VeroClear ............ccccccceuiininiiiiiiininnnne 7-4

Photo-Bleaching INStIrUCHONS ........c.ccovuevieriicieicecic e 7-4
StOTING MOAELS ... s 7-5

DOC-07000 Rev. A Vi



Objet500 - Connex 3 User Guide

viii



DOC-07000 Rev. A

About This Guide

Using This Guide...............
For More Information.......
Terms Used in This Guide

11



About This Guide

Using This Guide

This user guide provides instructions for installing, operating and
maintaining Objet 3-D printing systems. It explains how to use features,
and provides practical examples to guide you as you use the system.

The text and figures in this guide are based on the Objet500 - Connex 3 3-D
printer, printer software version 58.1.0 and Objet Studio software version
9.2.

This guide assumes that:

® all the hardware, software, and network components of your Objet
system are installed, configured, and operating correctly.

® the operator has a working knowledge of the Windows® PC platform.

For More Information

Visit http://www.objet.com/ for more details about Objet’s technology,
products and consumables, and for service and support contacts.

For other documents that relate to Objet500 - Connex 3 3-D printing
systems, and for this document in other languages, contact your regional
Objet Customer Support office.

If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to support@objet.com.
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Terms Used in This Guide

build tray

cleaning fluid

client/user workstation

Objet™ printer

Printer computer

Printer interface

Printer software

Digital Material™

Digital Material Mode

host/server workstation

Job Manager™

mixed part

mixed tray

Model material

Objet Studio™

OBJDF (Objet Digital Format)

DOC-07000 Rev. A

In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing model feed tubes and the printing
block, used to completely remove model material from the
system before loading another type of material in the printer.
The cleaning fluid is supplied in model-material cartridges.

The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

The Objet 3-D printer referred to in this guide.

The computer inside the Objet printer that operates it. (This is
sometimes referred to as the “embedded” computer.)

The GUI (graphical user interface) used for controlling the
Objet printer.

Software running on the computer inside the Objet printer,
that controls all printer operations.

Combinations of model materials fabricated in the printer
from the two basic model materials installed.

The printer mode used to print a job using two different
model materials. (This mode can also be used to eliminate the
need for performing the Material Replacement procedure
when printing with a single model material.)

The workstation that interfaces directly with the Objet printer
and is typically positioned next to it.

The part of Objet Studio software that manages production
jobs before they are sent to the Objet printer.

Models whose parts are printed using more than one model
material.

A build tray containing objects, each of which is designed to
be printed using a different model material.

Material used for building models.

The software with which users prepare jobs for producing
models.

The extension of a file that contains information about the
geometry of an object and the materials required to print it.
objdf files are created in Objet Studio.
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OBJTF (Objet Tray Format)  The extension of a file that contains all of the information
needed for a model-printing job on Objet 3-D printers. An
objtf file is used to send a print job to an Objet 3-D printer.

OBJZF (Objet Z Format) The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzf files,
a printing job can be saved as a single file, for convenient
storage and transfer.

Poly]Jet Matrix™ The technology of printing models by jetting multiple
materials simultaneously from the print heads. This
technology enables Objet500 - Connex 3 printers to print in
Digital Material mode.

resin The base substance from which photopolymer printing
materials are made for use in Objet printers. In Objet Studio
and printer-application screens, “resin” refers to cartridges of
model and support materials.

SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3-4.)

STL A file type used with Objet software. (For more information,

see page 3-4.)

Support material Material used for supporting the structure of models during
production.

1-4 DOC-07000 Rev. A
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Safety

Safety Features

Objet 3-D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Cover interlock

switch

Cover lock

N

UV screen

Circuit breaker

Grounded chassis

safety features may

W=

2-2

The power supplied to the UV lamp and the
motion motors is turned off when the cover is
opened.

WARNING: Do not defeat (override) the
interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

The cover is locked while the printer is
working. It is released when the printer reverts
to pause or stop mode.

WARNING: Do not defeat (override) the
safety lock. Doing so could result in serious
personal injury.

If the safety lock does not function correctly, do
not use the printer, and contact your service
provider.

The transparent section of the cover blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

The power to the printer is turned off in case of
electrical overcurrent.

Note: The circuit breaker is only accessible to
service personnel.

The chassis of the printer is grounded, to
prevent electrical shock.

Note: The power outlet must be properly
grounded, in accordance with the local
electric code, to provide this protection.

Cover interlock switch

If the Objet 3-D printing system is not used as specified in this guide, the

not provide adequate protection.

DOC-07000 Rev. A
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Symbols and Warning Labels

This following table lists the warning labels located on or in Objet printers.

DOC-07000 Rev. A

printer.

Warning Meaning Location Comments

Symbol
Hazard On the name plate | Read the instructions
(general) on the back of the | in this document

before operating the
printer.

Hot surface On the print-head | Risk of burns. Do not
block. touch this surface
after printing.
High voltage | Near the UV lamp | Risk of electric shock.
connectors.
Near the power-
supply enclosures.
Ultraviolet Near the UV lamps. | Risk of injury from
radiation ultraviolet radiation.
Moving parts | On the panel visible | Risk of injury from

when you open the
front doors of the
printer.

moving parts.
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Safety Guidelines

Printer

Installation

Printer

Operation

UV Radiation

Printer

Maintenance
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3

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the Objet system. If the system is not operated as specified,
the user's safety may be compromised!

> Installation and removal of the printer should only be done by qualified
service personnel.

» Connect the printer to the electric outlet using a power cord that is
safety-certified.

A\

The electric outlet should be easily accessible, near the printer.

» Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.

» Leave a minimum of centimeters between ventilation openings and
walls or other objects.

» The printer should only be operated by persons trained by an Objet
customer-support representative.

» All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment!

A\

Keep fingers and other body parts clear of the printer cover when
closing it.

Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!

If the interlock safety switch ever fails, do not use the printer.

YV V V V

Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamps and the print block.
The UV lamps used in the printer emit dangerous radiation.

» If the UV lamps remain on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Objet
service provider.

» Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.

» Notify co-workers and those who have access to the Objet system
before beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

DOC-07000 Rev. A
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Model and
Support
Materials

DOC-07000 Rev. A

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Objet system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing-material
cartridge used.

> Store cartridges of model and support materials indoors, in a dry area
with adequate ventilation, between 16-27 degrees Celsius (60-81
degrees Fahrenheit). Never expose them to flames, heat, sparks, or
direct sunlight.

» Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.

» Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.

» When handling UV-cured models that may not be completely cured on
the surface, common latex gloves are adequate.

» To prevent respiratory irritation, ventilate areas where model and
support materials are used. The ventilation system should totally
replace the air at least 20 times per hour.

» Clean up model-material and support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.

» Do not wash contaminated clothing at home; clothing should be
professionally laundered.

» Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re-expose the user when these items are worn.
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First Aid for Working with Printing Materials

Contact with
Skin

Contact with

2-6

Eyes

Ingestion

Inhalation

In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first-aid instructions.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

» Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

» Do not use solvents to clean skin.

» If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

» Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

» Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

The wearing of contact lenses when handling liquid printing materials is
not recommended. If the liquid splashes into the eyes when contact lenses
are worn, immediately remove the lenses and flush the eyes with water.

» Clean and disinfect the contaminated lenses.
» Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

> If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the patient warm but not hot.

Never feed anything by mouth to an unconscious person.

YV V V V

Oxygen should be administered by authorized personnel only.
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Waste Disposal

Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste.

DOC-07000 Rev. A

>

>

>

Y

When removing the waste container from the Objet printer, wear
neoprene or nitrile gloves.

To prevent liquid waste from splashing into the eyes, wear safety
goggles.

Liquid waste from the Objet printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

Empty model-material and support-material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.

Do not attempt to reuse empty cartridges, and do not puncture them.

Dispose of used cartridges and waste containers in accordance with
local regulations.

Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.
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Introducing the Objet 3-D Printing System

Welcome to Connex

The advanced capabilities of the Objet 3-D printing system are made
possible by PolyJet Matrix™ technology, specially developed by Objet for
printing models simultaneously with different model materials. For the
first time, you can achieve the following results when printing 3-D models:

*  You can prepare models for printing with designated model materials
and then print them —using two or three basic model materials loaded
in the printer, or combinations of these materials (digital materials).

* Parts of the same model can be made—simultaneously —from different
materials.

* Models made from digital materials can have unique physical
properties, depending on the materials used.

* You can print objects that have a “coating” made from a different
material than the main part of the object.

In addition, because Objet printers can be loaded with two different
materials, and can print simultaneously with combinations of them, you
can streamline and economize the process of producing models:

* You can print models made from different (single) materials on the
same build tray (“mixed tray”), in the same print job. This eliminates
the time-consuming need and expense of loading another material,
flushing the system, and sending a separate job to be printed.

* You can quickly alternate printing jobs with any of the model materials
loaded —or with material combinations—again, without the need and
expense of replacing materials.

The Objet system also enables you to split models into component parts
(“shells”) so you can isolate, manipulate and print parts of a model.
However, you have ultimate control when separating models into shells by
preparing stl files with your CAD software. Then, with Objet software, you
can assign model materials and other characteristics to the shells.

Figure 3-1: The 3-D Printer
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Work Configurations
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The 3-D printing system can be set up as a single-station system or as a
multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3-D printer, acts as a job
manager that sends production jobs to the printer for production.

Figure 3-2 shows the printer set up in a multi-client configuration.

Client
workstations

Objet server

Printer
workstation

Objet printer

Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a
client station or as a master station (server or standalone station).

The Objet software arranges the jobs it receives according to their priorities,
model-material type, and other factors. In multi-workstation
configurations, the operator of the server —typically the production
administrator —has total control over the jobs sent to the 3-D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.
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Source Files

STL Files

SLC Files

Objet 3-D printing systems produce three-dimensional models designed
with most 3-D CAD tools and with other job-specific 3-D applications.
Objet systems accept:

e STL Files
e SLC Files

Objet systems feature the capability of producing both types of model files
simultaneously.

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.

For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The result is that high-quality object descriptions mean very heavy
files.

Most CAD software can export STL files. The Objet system utilizes these
files for building models (rapid prototyping), and also for directly making
molds for mass-producing items.

STL files are ASCII (text) files. The content of each file begins with “solid”
and ends with “end-solid” (both lower case). Between these keywords is a
list of the triangles that describes the faces of the solid model. Each triangle
defines a single normal vector directed away from the solid’s surface,
followed by its X-Y-Z coordinates. These are expressed as Cartesian
coordinates and are floating-point values. The coordinates of all triangles
should be positive and should fall within the volume of the model.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid-object images displayed from
STL files.

Printing Materials

Objet printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:

* Model material —which makes up the finished model

* Support material —which fills gaps and spaces in the model during
printing, and is removed after printing
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Storage

Shelf Life

Exposure to
Light

Safety
Considerations

W=

Disposal
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Materials used for printing models with Objet printers are made of resins,
which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
Objet printing materials.

*  When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

* Store material cartridges indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
If exposed to heat or flames, cartridges may burst or ignite.

* Signs of premature polymerization in material cartridges may include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

* Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:
* Do not expose to flames, heat or sparks.

* Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

* Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

You can find more safety information about resins in “Safety Guidelines” on
page 2-4, and “First Aid for Working with Printing Materials” on page 2-6.

Dispose of cartridges of Objet model and support material in accordance
with all applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.
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Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the Objet 3-D printer. Therefore, it is recommended that you use ventilation
or air-conditioning systems, if necessary, to keep the work area within the
following ranges:

+ 18°-° C (64°-°F)
* 30%-70% relative humidity
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Workstation Requirements

The following tables list the requirements for computer components used
with Objet 3-D printer software.

Requirement

Server workstation:

(RN I Standard desktop computer (not a portable computer)
Mouse/Keyboard |Server workstation:

Connection USB, PS/2, or RS-232 (wireless components unacceptable)
Processor Intel® Core™ i3 or better

Operating System

Windows® 7 64-bit!

Professional, Ultimate, Enterprise, Starter, Home Basic,
Home Premium editions

Graphics Card?

Open GL® with 1 GB of memory or more

For dental applications:
¢ ATI™ Radeon™ HD 5970, with 2 GB of memory, or
« NVIDIA® GeForce® GTX 285, with 2 GB of memory

RAM

8 GB or morel

CD Drive

IDE CD ROM

Hard-Disk Drive

80 GB or larger

Network Card

LAN TCP/IP
(2 for server workstation; 1 for client workstation)

Video Card

Server workstation: VGA connector3

Monitor

Resolution: optimum for screen used
Color quality: 32 bit

Monitor Cable

VGA connector?

1. On 64-bit operating systems, Objet Studio runs as a 32-bit application, but it can
utilize up to 8 GB of memory.

2. The following graphics cards were tested in Objet labs:
 NVIDIA® Quadro® Family —FX570, FX1700
 NVIDIA® GeForce® Family —6200 TurboCache™, 7300 GT
o Intel® Express Chipset—82915G/82915GV/82910GL, Q965/Q963, Q35,

Q45/Q43, 82852/82855

o ATI® display adapter—Radeon™ HD 5670, Radeon™ E6760

3. The KVM switch requires VGA video connections. If the server workstation
has a DVI video connector, a VGA adapter is needed. The cable from the
monitor must have a VGA connector.

Note: You control both the built-in printer computer and the server workstation
with same keyboard-monitor-mouse set by using a KVM switchbox.

DOC-07000 Rev. A 3-7



Introducing the Objet 3-D Printing System

Preparing Files for Use with Objet 3-D Printing Systems

Converting
CAD Files to
STL Format

Converting
Files to SLC
Format

Before using files with Objet 3-D printing systems, you must convert them
in your CAD program to either STL files or SLC files. (For an explanation of
these file formats, see “Source Files” on page 3-4.)

After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics, by Materialise) before
opening them in Objet Studio and producing the model.

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.

2. Inthe Save As dialog box, open the Save As Type pull-down menu and
select *.STL.

3. Click Options and set the following parameters:

* Total Quality —approximately 0.1 mm (deviation tolerance / linear-
dimension tolerance)

* Detail Quality —approximately 4° (angle tolerance)

Note: Lowering these values produces more accurate models, but
results in larger files and longer loading and processing times. For this
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5-32.
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Objet Studio Software

3
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Objet Studio software for the Objet 3-D printing system consists of two
main screens:

* Tray Settings / Model Settings
* Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet 3-D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic
procedure:

Inserting one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

=L N

Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Objet 3-D printer for production

Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet 3-D printer.

* In Objet Studio installed on the directly-connected computer (server),
the Job Manager screen displays the queue and status for all jobs sent to
the 3-D printer by the server itself and by all client computers on the
network. All jobs displayed can be edited and manipulated.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3-D printer server
from that computer. Only these jobs can be edited and manipulated
from the client computer.

Client computers can be connected, via the local network, to different Objet
3-D printers, but only to one at a time. The Job Manager screen displays
the status of the 3-D printer to which the client is currently connected.
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Installing Objet Software

How to Install Software for the Objet 3-D Printing System

The Objet Studio setup wizard guides you when installing the Objet
software. During installation, you must choose to install either the server

(“host”) application or the client application.

To install Objet software:
Insert the Objet Studio CD into the disk drive.

Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).

1.
2.

Open the CD-drive folder and select Setup.

If you are installing an Objet Studio upgrade, make sure that your
printer is compatible with it by checking the list displayed.

0Objet Studio Setup

N
|

. Please note...

i This version of Objet Studio is *not™ compatible with the following

versions of the printer software:

- Connex500, 57.0 (and below)
- Connex 350, 37.0 (and below)
- Eden500V, 50.2 (and below)
- Eden350V, 36.0 (and below)
- Eden260V, 27.0 (and below)
- Eden350 (all versions)

- Eden330 (all versions)

- Eden2a0 (all versions)

- Eden250 (all versions)

- Alaris30 (all versions)

If the printer software is incompatible, printing will not be possible
after this Objet Studio installation.
For more information, contact your Objet service provider.

To install Objet Studio, dick OK.

oK I Cancel |

Figure 4-3: Objet Studio compatibility check

To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.

If you click Yes, the following screen should appear.

i Objet Studio 9

Welcome to the Objet Studio 9 Setup Wizard

The inztaller will guide you through the steps required to install Objet Studio 9 on your
computer,

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

[ Cancel ] [ < Back

Mewt > l

Figure 4-1:0bjet Studio installation wizard—Welcome screen

6. Click Next to begin installation.
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7. Inthe Select Features screen, select the required installation option.
Select Objet Studio for a server computer...

® if you are installing Objet Studio on a server (“host”) computer —
the computer directly connected to an Objet printer.

® if you are installing Objet Studio on a standalone (off-line)
computer.

Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares
print jobs and then sends them to a server computer.

i Objet Studio

Select Features

Select the prefered Objet Studio Installation twpe for your computer

(%) Obiet Studio for a server computer.

() Obiet Studio for client workstations.

[ Cancel ] [ < Back ] [ Mewt >

Figure 4-2: Objet Studio configuration selection

8. In the Select Installation Folder screen, verify the destination folder and
click Next.

% It is recommended that you do not change the default destination folder.

Click Disk Space to check the space in the destination folder.
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Figure 4-3: Objet Studio installation-folder selection

9. In the Confirm Installation screen, click Next to begin installation.

{i Objet Studio 9.2.6.0

Select Printer Type

=101 x|

~ h
'?;?_-a 23]

Select an Objet Printer.
 Objst24
 Objet30
" Objet30 Pro
" Objet30 Scholar

@ Toie e Bie e Nhie Nhie Nie |

Connex260
Connex3s0
Connex500
Eden 260
Eden 350V
Eden 5000

Obiet S00(2I)

Obijet 1000

Cancel

Tewt > |

Installation begins and a progress bar appears, showing the progress of
the installation process.

i Objet Studio 9

Obijet Studio 9 iz being installed.

Flease wait...

Installing Objet Studio

Cancel

Figure 4-4: Installation progress bar
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When the Objet program installation is complete, the final InstallShield
Wizard screen appears.

i Objet Studio 9

Installation Complete

Obijet Studio 9haz been successfully installed.

Click "Close" to exit.

Cloze

Figure 4-5: Final installation screen

Sometimes, you must restart the computer to complete the software
installation. You can do so now or at another time.

Note: Make sure to remove the CD from the disk drive before restarting the
computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:

® Objet Studio

® Stop Job Manager (for servers and standalone stations)
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Using Objet Studio

Objet Studio Interface ..........cccoeeviviviiiiciiciiicc 3
Preparing Models for Production ...........cccccovvviiiiiiiiininnnne, 7
Placing Objects on the Build Tray .........ccccoevvviiiceiiccce 8
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Model-Material Settings..........ccccoeueueerininininiiiciicicireeecccae 21
Changing the Model Material .........ccccceeiuiiiiiinnniniiiiciciins 22
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Objet Studio——b. ETEe ) - —Help
) T
Commrﬁggﬁ / Tray Settings Job Manager
- Standard
Quick Access 25 too|bar
toolbar Tt F stimate w Open Save ~L Active:
ribbon’
Model Tree Maodel Build Process Selection
pane Job
Manager
tab
Model Tree ]
+@ Trayl

The Objet Studio interface consists of two
main screens:

* Tray Settings—for arranging models
and preparing them for printing.

This screen is described below.

* Job Manager—for monitoring and
managing print jobs.
This screen is described in “Monitoring
and Managing Print Jobs” on page 76.

Each is controlled by menus and icons on
its own ribbon. An additional ribbon,
Model Settings, displays controls for
configuring and manipulating selected
models.

Objet Studio anticipates your work flow by
displaying and enabling the options
relevant to your current task. For example,
when you first open Objet Studio, the
Model Settings ribbon is disabled until you
place a model on the build tray. Similarly,
menu options available from the Standard
Toolbar menus are enabled or disabled to
match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in
“Customizing Objet Studio” on page 64.
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Tray Settings Job Manager

Objet Studio: Objet500 Connex3

G B2 3 & v L ES w6 & de B | verosrey
O‘ B3 E - Pocket Card Holder Objet Studio: Objet500 Connex3
1 —/ Tray Settings Model Settings Job Manager
poe My = = - — = L il M
Ribbon Group Purpose When Tray Model
Command enabled Settings  Settings
Ribbon  Ribbon
B Setting display | Always.
g%% B colors. d d
By Leqgend
Material =
Colors
Selecting Models are on
perspective and | the build tray.
zoom level. d d
Choose to select | Models are on
a plane. the build tray. d d
Change the Models are on
perspective of | the build tray.
the active pane. d d
VeroWhite - Single Material  ® Build tray
- ) _ is empty. d
VeroGrey Multiple Materials Models are
WeroBlack < not
Currently loaded: VeroGrey, VeroWhite, VeroWhite selected.
Undoing or After an
redoing actions. | action or d
oinect
selection.
i Mew Opening and Models are
N saving files. not selected. d
IR
-E,‘L Save MNew Open Save
F||E File
%) Placing model | Always.
files on the build d
Inserk tray.
Model
Pre-build/build | Models are on

EEE

commands. the build tray. d
Placement Validate Estimate Build

Setting model | A modelis

dimensions. selected.

v
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Group Purpose When Tray Model
enabled Settings  Settings
Ribbon  Ribbon
Cutting, A model is
copying, pasting | selected.
and de?eting d
models.

Moving, rotating | A model is
and resizing selected. d
models.

* Assigninga | A modelis
material toa | selected. d
model or
shell.

* Separating a
model into
shells.

Assigningmodel | A model is
finish an selected. d
setting support
strength/
“hollow.”

Setting amodel’s | A model is
unit of measure | selected. d
(millimeters or

inches).

tooltip. The “Undo” and “Redo” tooltips change to reflect your last Objet

% To quickly identify an icon, move the cursor over the icon to display its
Studio action.
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Objet Studio
Commands
Menu
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Clicking the Objet icon (in the upper-left corner) opens the Objet Studio
Commands menu. This menu displays basic application commands and
options.

O Pea® -

“d"' Hew Recent trays
= 1 testiengn
‘? Open...
2 Trayad
=é Save
3 C\Program Files. .\ Trayds
’
é o 4 Ci\Program Filesy.. \Trayl

I@ Save Bitmap, . Ctri+B

?3@ Import Packed Job...

‘?@ Export Packed Job...

.-{I_;n‘ Build Properties. ..
"LE User Preferences...

ri Prinker Properties...

Restart

The Options button opens a dialog box for customizing Objet Studio.
Options &

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement
Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]
O Mever

(@) Ahways
(O \When under the tray

Large Filez

() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local

(®) Original

[ Ok H Cancel ]

The Model Tree pane lists the objects placed on the build tray in a parent-
child hierarchy. By default, the pane “floats” — that is, you can move it to
another position on the screen and resize it. Alternatively, you can fix its
position at the left of the application window, and even hide it.
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Preparing Models for Production

Model preparation involves the following basic steps:

1. Place objects or assemblies on the build tray.

2. If necessary, manipulate the object’s orientation and position.
3. Select the materials and model finish.

Just as Objet printers can produce different models on the build tray using
different materials, you can produce components of a model with different
materials. To do this, each part of the model must be a separate st/ file. If the
model’s component parts were not saved in the CAD software as separate
stl files, you can use Objet Studio to separate the model into component
parts. (This is described in “Splitting Objects into Components” on page 16
and in “Dividing Objects” on page 58.)

OBJDF Files: An objdf file describes both the geometry of a single object and the

Overview materials, and finish required to print it. The objdf file can represent an
object that is a single sl file, or an object assembled from component st/
files.

Objet Studio enables you to split an st! file representing a complex object

into an assembly of component st/ files, and save the assembly as an objdf
file. Each part (st! file) described by the objdf file can have its own model-

material characteristic, so that the Objet printer produces the component

parts from specific materials.

Another use for objdf files is for saving a group of separate objects on the
build tray as one unit, together with their relative positions and materials.
This is especially useful for producing models in the future with the same
materials. In fact, when you save objdf files, you specify materials for
printing models without regard to the material cartridges loaded in the
printer. The same object can later be placed on build trays for printing. Each
time you send a build tray to the printer, you decide whether to allow
printing with substitute materials or only with the materials specified.

The Connex version of Objet Studio enables you to display, manipulate and
print component parts of a model assembly that was saved as an objdf file,
since each component is a separate st file. This can be useful for printing
only specific parts of a model.

Model Files To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
several ways:

* Dby inserting individual st/ or slc files (or an assembly of stl files).
* by inserting an objdf file (an assembly).
* Dby pasting objects that you copied to the Windows clipboard.
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Placing
Objects on the
Build Tray
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To place an object on the build tray using stl, slc or files:
Open the Insert dialog box—
* From the Object menu, select Insert.
or—
* On the Arrange Tray ribbon, click .
or—

* Right-click on the build tray, and select Insert from the context
menu.

The Insert dialog box appears.

Insert @g|
Look irn: | I Samples w €) ¥ El,
3 |Z)Basic Shapes
\ :3 IZichess

My Recent ) Connex Samples
Documents |23 Connex_samples

= |)Eden_alaris_Samples
L% ) Images
Deskiop |y sample file

IZ)5LC Files
I)STL Files
| Text3D
My Documents QTrayl y
W) sample file
=1
o
48
My Computer
‘:‘] File name: zample file A
>
by Metwork, Files of type: STL Files [ st w
Units: Millitd eter w [ Azsembly
Mumber of Copies : |1 e E] [] Orient Automaticaly

Coordinates
Width (] Depth [v)  Height [£)
Extents 22.9 50.2318  [229

Preview

2. Inthe Look in field, display the appropriate folder.
In the Files of type field, select the file types to display (st/, slc, ).

Select the desired file, and make sure that it appears in the File name
field.

If the Preview check box is selected, the object is displayed in the dialog
box.

Note: You can open several stl files at once, to place several models on the
build tray. If you select multiple stl files that make up an assembly,
you can select all or some of the parts. To print the entire model,
select all of an assembly’s component stl files, and select the
Assembly check box. This positions the parts as a complete,
integrated model instead of as independent parts. The effects of
selecting the Assembly check box—in both the model tree and the
build tray display—are shown in the following figures.
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Figure 5-7: Assembly check box selected—stl files are placed as an assembly

Figure 5-8: Assembly check box not selected—stl files are placed as parts

The Model Settings ribbon is displayed when objects are placed on the
build tray.

Select any of the following options, as required:
* Units—Millimeters or inches for the object’s units of measure.

The 3-D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 36.

* Number of copies —How many copies of this object to place on the
build tray.

* Orient Automatically — Automatically orient objects on the build
tray for efficient model building.

* Assembly —Mark this check box if you selected multiple st files
that are part of an assembly.
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Note: The Extents values displayed in the Insert dialog box’s Coordinates
field, represent the maximum dimensions of the object on each axis.
These dimensions correspond to the virtual “bounding box”
surrounding the object see figure 5-49 on page 36).

6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

N ke s Pocat Cirdhides Objet Stdio: Conneic SEE
T 3o Mg G- e - e - ook - Sy - -
X B Ry e Bigie x mm 00 A =
O O] seba | Hoe pastom o |7 8500 ol ,g’x.p.u.l..w.l. Srge  Zoom Legerd
. Cerment * = 6 o View* Tray Matensl
B8 || Semtin Mariptole [ s Cptiern Mg M Vo

Mosdel Tree
B -1

" )| Potat Card Heldae

T T R I T

The Model Settings ribbon is displayed when objects are placed on the
build tray.

If the object is over a certain size, the Loading Placed Elements dialog box
may appear.

Loading Placed Elements

todel Mame IE:"-...."-.GHender"-.B in%Trayl obitf

[ ]
Plac:ed Elerment II::"'...."-.testI:uuiId.DI:uidf
[ |

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 48).
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Opening files Before placing files on the build tray, Objet Studio must extract the

component st! files together with information about their orientation and
materials. To do this, Objet Studio creates a folder with the same name as
the file, in the same location.

Look in: |L'f) Samples V| € ] 7 il sl

&

My Recent
Documents

by Metwork,

|C5)Basic Shapes
() chess

|C5) Connesx Samples
|C5) Connes_Samples
[C)Eden_alaris_Samples
@Images
I5)sample File
[C)5LC Files

[C3)5TL Files

(5 TextaD
@Trayl

[t

File name: |Tray1 A |

[ Inzert ]

Filez of type: | Obijet Digital Files [* objdf] hd |

[ Cancel ]

Urits: Millitd eter v

~

Mumber of Copies : |1 £ [] Orient Automaticaly

Coordinates
Width (] Depth [v)  Height [£)
Extents

I aterials
Packed Azzembly File
Wercwhite

Preview

Figure 5-9: Insert dialog box ( file)
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Opening Objet
Tray Files

5-12

You can open trays that were saved as objtf files, for example, a tray you
saved while preparing it for printing, and now you want to continue

preparing it.
To place an object saved as an Objet Tray File (objtf) file on the build
tray:

From the File group, click .

or—

From the Objet Studio Commands, select Open.
The Open dialog box is displayed.

Open E|E\

Look in: | (£ Basic Shapes v @2 > @
e
My Recent
Documer I
@
Deskiop
My Documen I
My Computer
ﬁ.‘] File rame: [Trapn v [oeen |
3
MyNetwork  Filesofpe: | Dbt Tray Files [* o) v [ caneat |
Coordinates
[+] Prewizw

2. Select the desired file, and make sure that it appears in the File name
field.
If the Preview check box is selected, the object is displayed.

3. Click Open.
Objet Studio opens the tray file.

DOC-07000 Rev. A



Objet500 - Connex 3 User Guide

Stl file loading
preference

DOC-07000 Rev. A

If there are identically named st files in more than one location, you need
to ensure that the correct component st/ files are linked to the objtf file. For
example, if there are identically named st/ files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you
can set the default location from which files are loaded.

To set the Load Order:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
2. In the Options dialog box, display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement
Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]
O Mever

(@) Ahways

(O \When under the tray

Large Filez

() Load Ful
(O Load Partial [feducad

oad Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-10: Options dialog box, Settings tab

3. Under Load Search Order, select an option:
* Local—to load files from the location where they were last saved.
* Original —to load files in their original location.

4. Click OK.
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Quick-Access You can access common commands for working with objects on the build
Model tray with the convenient Model Toolbar and context menus.
Commands

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

m QXH, W S
FullZure720 A o

The table below describes the Model Toolbar icons.

Icon Description
'J Applies a matte finish to the model.
Applies a glossy finish to the model.
<
r Opens the Advanced Properties dialog box for setting the
‘%} Grid Style and the Hollow option.
‘:E"S} Enables dragging an object.
L Opens the Transform dialog box for changing the
‘jif object’s position and scale.
= Toggles the Lock Model Orientation setting.
TangoBlack+ - | Allows you to choose the printing materials.
% Enables you to apply a coating to the model, or change
Q the coating previously applied.

Right-click model If you right-click on an object, a pop-up context menu is displayed from
menu  which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See “Building a Quick Access Toolbar” on page 89.
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Copying and If you need to duplicate objects on the build tray, you can, of course, insert

Pasting the same object from its file more than once. An easier way, however, is to

Objects copy and paste the object. You can copy objects from the build tray or the
model tree—individual or multiple parts or assemblies. The objects copied
remain in the Windows clipboard until you paste them onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

need to manipulate or configure objects before inserting them in your
production build tray. For example, if you need to change the model material
of an object (saved as an objdf file) to match the model material already
used in the production build tray, you must do so before inserting the
object—on another tray. Copying and pasting also allows you to utilize
objects already configured on previously-used build trays for newer
projects.

% Having multiple Objet Studio windows open can be convenient when you

You perform the Copy and Paste commands as in other Windows
applications:

* from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

* You can set the distance, on each axis, between the duplicate objects.

*  You can manipulate mirror images of the original object, and flip them
on selected axes.

Paste Special E|

Mumber of Copies -
Delta
w100 Y (100 Z |0 T

b aripLilate
Mirrar A Ay  dz
Flip [F b= i Az

[]5ave as Defaults [ (] l [ Canicel

Figure 5-11: Paste Special dialog box
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Selecting
Objects

Splitting
Objects into
Components

5-16

To manipulate an object on the build tray or assign characteristics to it
(model material, building style etc.), you must first select the object. You
select an object by clicking it, either on the tray or in the model tree. Its
image on the build tray changes color (to light blue, by default) and its
name is highlighted in the model tree. You can select multiple objects by
drawing a box around them with the mouse cursor, or by pressing the Ctrl
or Shift keys while clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

* Select All
* |nvert Selection
* Undo Select object

Edit = \jew ~ Ohjeck -

A undo Select object

Select All
Invert Selection

Sometimes, you need to select individual elements of an assembly. Other
times, you need to select the entire assembly. The Selection icon displayed
on the ribbon determines what will be selected when you click on the
model:

W %

Select Seleck
Element ~ Group *

Selection Or Selection

To change the selection action:

1. On the Arrange Tray or Model Settings ribbon—
B S

Select Select
Elemant = Group *

a. Click the Selection icon: ..., O —pw, -

b. On the flyout toolbar, click the appropriate icon:

Select Element

Select Group

|ﬂi.@§.ﬁ'|

Figure 5-12: Selection flyout toolbar

You can convert a complex object to an assembly of component parts. To do
so, you split the st! file that represents the object into a group of separate stl
files, each one representing a component. (This is referred to in the Objet
Studio interface as separating the object into shells.) You can then assign a
model material to each stl file, and you can save the newly-created
assembly as an objdf file.
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To split an object into an assembly of component parts:

1. If the object is not displayed, place it on the build tray by inserting its st/
file (see “Placing Objects on the Build Tray” on page 8).

The object appears—on the build tray and in the model tree pane—as a
single part. It is assigned, by default, the “primary” model material. (If
Objet Studio is configured with a secondary material, you can assign
it—or a digital material —to the entire object. This is explained in
“Model-Material Settings” on page 18.)

Figure 5-13: Object placed on the build tray from a single stl file

Note: There is no need to resize or arrange the object on the build tray at
this time.

2. With the object selected:
* From the Object menu, select Separate into Shells.

or—
ﬂ% Separate ko Shells
¢  On the ribbon, click .

A dialog box opens in which you can specify where to save the
component st! files. (By default, Objet Studio offers to save the new files
in a folder in the same location as the original st! file.)

Separate to Shells

Save o Folder: l:l"-.Ei-Eln'l leshSTL Files\Applications - wrench Eey

[ Q. ] [ Canicel

Figure 5-14: Folder selection for saving stl files after splitting into shells
3. Click OK.
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Objet Studio splits the object into an assembly of component parts, each
a separate stl file (“shell”).
The object appears—on the build tray and in the model tree—as an

assembly of parts (“shells”). You can assign each part a different model
material (This is explained in “Model-Material Settings” on page 18).

Figure 5-15: Object after being converted to an assembly of component parts

Model-Material Before placing objects on the build tray in Objet Studio, you should pay

Settings attention to the material selection settings on the Arrange Tray ribbon.
VeroWhite < Single Material
VeroGrey < ¥ | Multiple Materials
VeroBlack w7

Currently loaded: VeroGrey, YeroWhite, VeroWhite
Figure 5-16: Material selection settings

* By default, the material selection settings on the ribbon correspond to
the three model cartridges loaded in the printer.

* The materials displayed are basic model materials. These materials can
later be combined to create digital materials (see “Digital Materials” on
page 20).

* The material displayed on the top (VeroWhite, in the figure above) is
considered the primary model material (“Model-1”). It is assigned to
objects that do not have a material assignment when you place them on
the build tray. For example, since st/ files do not contain information
about the model material, Objet Studio assigns the primary model
material to them. Also, if you try to insert objdf files whose assigned
materials are not recognized by your version of Objet Studio, you can
insert the file by substituting the primary model material for the
missing materials.

* Select Single Material if you want to print using only one material —all
of the material drop-down menus contain the same material. If you
decide to print with multiple materials, the material in the top drop-
down menu remains assigned to the object until you select another
material.

* If you insert an objdf file into an empty build tray, and the model-
material assignment does not match the settings on the Arrange Tray
ribbon, these settings are changed automatically. However, if there is an
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object already on the build tray whose materials do not match the
material assignment in the objdf file, you cannot place the new object on
the tray. To print this object, you have the following options:

O Instead of printing it on the same build tray, print the new object as a
separate job.

O Change the materials assigned to objects on the build tray to match
those assigned to the new object (see “Changing the Model
Material” and “Assigning a Model Material to Objects,” below).

O Change the materials assigned to the new object before inserting it,
so there is no conflict with the settings on the Tray Settings ribbon.

To change the materials assigned to an object before inserting it:

1. Open another Objet Studio window, by running the application from
the Windows Start menu.

2. Insert the new object (objdf file) into the empty build tray.

3. Change the material selection settings on the Tray Settings ribbon to
those used on the other build tray.

4. Assign materials to the object (see “Assigning a Model Material to
Objects” on page 23).
Select the object and copy it.

6. Display the other Objet Studio window, and paste the object onto the
build tray.

Note: You can save the object with the new materials either as a new objdf
file, or by saving the original file with the changes.

YeroCyan < Single Material

VerohMgnt h ¥ Multiple Materials
VeroWhite [l

-Em VeroCyan = Single Material
.‘-fern( YVerobgnt
DVEro ¢ VeroWhite =

. VErUh_D VeraClear [, VeroWhite, VeroElack
[ ]verav B verocyan
B veroy [ veroGrey

. WYerohMgnt

Figure [ | veroWnite pear on the ribbon,

ou 1 combination of
%,hem- |:| WeraYellow -

three three

4

| Multiple Materials
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Color selection You can display the material color options as a color pallete. From the
pallete Tools menu, select Color material selection and then Select from color
pallete.
ReD-cMw-018-DM -Gl |

RGD-CM-006-DM

Strong Reddish Purple

Figure 5-18: Color selection pallete for assigning materials to objects

E RS

'RGD-CMW-018-DM -

RGD-CM-006-DM
Strong Reddish Purple

Figure 5-19: Color selection pallete from Model Toolbar

Note: The color selection pallete will only be displayed if one of the
following combinations of primary materials are selected:
* VeroCyan and VeroMagenta and VeroWhite
* VeroCyan and VeroMagenta and VeroYellow
* VeroCyan and VeroWhite and VeroYellow
* VeroMgnt and VeroWhite and VeroYellow
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Surface Finish

DOC-07000 Rev. A

Models can be printed with a matte or glossy surface finish. To create a
matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:

1. Select the model.

2. Select Matte or Glossy in one of the following places:
* Model Settings ribbon, Options group
* Model Toolbar
* right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects” surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 48.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated logically for your needs, according to the
considerations explained in “Model Orientation” on page 5-32.

Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum

orientation and position, or you can control them.

Automatic
Orientation

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the

orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

2 [x]|
Lookir: | (£ Samples Y o® @
3 |E8asic shapes
<) |2chess
MyRecent | |C)Connex Samples
Documents |2 Connex_Samples
— [)Eden _plaris_Samples
Docttop || Csample il
|C215LC Files
|E)5TL Files
|EaTextad
My Documerts | | So12"t
JppTrayl
-
e
My Computer
‘,J File e Tra v
My Metwork | Files of type: | Objet Digital Files [ obidt) v|
Units, | Wit ster ~
Number of Copies: (1 % (] ] Drient Automaticaly
Coordinstes
Width ] Depti[v)  Height )
Extents
Materisls : -
[ Packed assembly File
Verchwhits,
. [#] Preview
Insert @g|
Lock in: | 55 Samples e I = e
5 (C)Basic Shapes
9 Dichess
MyRecent | [C)Connex Samples
Documernts |5 Conne_samples
— (C)Eden_Alaris_Sarples
: [Simages
Deskiop (C3)5LC Files
[E)STL Files
§ () Textan
_J (STrayt
Mo Dooments || N
—
58
My Computer
‘_} File rame sample fle v
3
My Network | Files of type: STL Files (1) v
Urits Millibeter v Oassembly
Nurnber of Copies : |1 S 7T ovient Auomaticaly
Coardinates
Widh [l Depth[v)  Height [2)
Edents 229 Bozmn 22
[ Preview
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applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see “Default Settings” on
page 70.

Q You can change the default setting, so that automatic orientation is not
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Automatic After placing several objects on the build tray, you can let Objet Studio

Placement arrange them on the tray for printing. This ensures that the objects are
positioned properly, and that they will be printed in the shortest time and
with a minimum of material.

To automatically arrange objects on the build tray:
» On the Tray Settings ribbon, click .

or—

From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-20: = - Tray before
objects are properly arranged

Figure 5-21: "= Tray
arrangement when applying automatic placement

Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

* The physical characteristics of each type of model material you use can
affect the positioning of objects on the build tray. Therefore, select the
material before running Automatic Placement.

%( * For best results arrange the tray with Automatic Placement, on the Tray
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Model Orientation
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The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3-D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

» Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along
the Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

» Any surfaces that come into contact with support materials become
matte.

» Since models are built up, on the Z-axis, in 30-micron layers, it is very
time-consuming to print a tall object. From this point of view, it is
advisable to place the object's smallest dimension along the Z-axis.

» Since the print heads measure about 2 inches (5 centimeters) on the Y-
axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

> Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

Recess-Up Rule

This rule considers models containing surface recesses.

» Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

> The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.

Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

» It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.
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Manipulating Objects on the Build Tray

Positioning When you use the automatic positioning option to arrange objects on the

Objects on the  build tray, the objects are positioned directly on the tray. If you do not

Z-Axis insert objects with automatic positioning, they often appear either above or
below the tray.

millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

% In practice, the Objet system prints all models on the build tray on a one-

To position objects directly on the tray:
1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.
2. Inthe Automatic Lay On (Gravity) section, select Always.

Other Z-axis options (in the Automatic Lay On section):

* When under the tray —The display of objects that are below the build
tray is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is
not changed.

Valid Object You can ensure that models do not overlap when you position them on the
Placement build tray, and that they do not extend beyond the tray.

To ensure valid object placement:
1. From the Tools menu, select Constraints Settings.
[ x|
Constraints

Colars
Default Color
Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion
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2. Select Dynamic check to identify:
* invalid object placement while placing objects—On Drop selected.
* invalid object placement after moving objects —While Drag selected.
* objects placed beyond the tray’s boundaries —Outside Tray selected.
* objects that overlap—Object Collision selected.

tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can
also manually check for problems after positioning objects.

Q Even if you do not use Dynamic Check when placing objects on the build

Note: Remember that Objet Studio calculates the space occupied by an
object including the “bounding box” surrounding it (see figure 5-40
on page 44).
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Using a Grid to Displaying a grid on the image of the build tray can be useful when

Position positioning objects. You can make use of this feature by selecting the
Objects following menu options.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid | When moving the object, it aligns with the nearest

grid line.
Tools > Options > Enables you to change the grid origin
Grid (X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them —from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options §|

Appearance | Grd Manipulate | Display | Settings
[ Display arid
[15napto grid
Colors
Tile size 20 2 mm
Base -
Major division |10 2| tiles
I = Center -
Murnber of tles |32 e
= I ajor -
Line style Dot hd
Uriits Millit eter e
Oigin [0 3o 2o < |mm
Ok Cancel

Figure 5-22: Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement
Units
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3-D files contain an object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:

> In the Insert dialog box, Units field, select Millimeter or Inch:

Insert

Look in: | I Samples v | Q ¥ m-
Y |C5)Basic Shapes
4 23 () chess
My Recent |C5) Connesx Samples
Documents |23 Connex_samples
— [C)Eden_alaris_Samples
=
|_ CImages
Desktop I5)sample File
[C)5LC Files
: [CSTL Files
"‘/' [ Text3D
Trayl
My Documents Dotray .
@ sample file
My Computer
- File name: | & | [ Inzert ]
My Network | Files of type: 5
Millitd eter v

To change units of measurement on the Model Settings ribbon:
1. Open the Units flyout toolbar.

mm
| o

Millirmeter

w

e

inch
| |

Figure 5-23: Units flyout toolbar
2. Select the measurement units desired.

To change units of measurement with the Standard Toolbar:
1. From the Object menu, select Change Units.

killitd eter
Ihich

Figure 5-24: Model Units dialog box
2. Inthe Model Units dialog box, change the setting and click OK.
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Setting Model
Dimensions

Repositioning
Objects

5-30

You can change the object’s dimensions by changing the coordinates in the
Dimensions group on the Model Settings ribbon.

i
i
i

l

54,65 ~
34,80
10,00

Dimensions () ]

Figure 5-25: Dimensions on the Model Settings ribbon

Note: You can change the height of the objects on the build tray only if this

is allowed by the Objet Studio settings.

You can manually move and rotate an object on the build tray with the
arrow keys, or by dragging it with the mouse.

To manually manipulate an object:

1.

Select an object by clicking it on the build tray, or in the model tree
pane.

Click on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-26: Manually moving an object
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3. If you click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-27: Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

Using the Transform You can make precise changes to an object by changing the properties in the
Dialog Box Transform dialog box.

To access the Transform dialog box (when an object is selected):
* Click '3; on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

Transform rz|

“fidth[<] DepthlY] Height(Z)]
Translate:| 0 :| | [ | |

SN,

1 A

Fotate: | 0 0 :|

Scale: | B

-

1;|

Figure 5-28: Transform dialog box

To change an object with the Transform dialog box:

» Change any of the values, then click Apply to see how the object
changes on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
» Click Reset.
Note: The objet does not change. Any changes previously applied remain.

To undo all changes made with the Transform dialog box:
» Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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%1

Changing an There are severe
Object’s build tray. Elg:_l':i -
Orientation el
To rotate an ob, I?ﬁ'& e
|

» Select the obj
Tor & | & :

Select Select
Element ~ Group *

for changing the orientation of objects on the

—

> the Object menu options.

ne:
st |Sakeion or—
From the Tools menu, select Plane Alignment > Select Plane.
5. Click on part of an object on the build tray.
The selected plane is displayed.
Figure 5-29: Aligning by plane
6. On the Alignment toolbar, click an appropriate icon to change the
alignment.
or—

From the Tools menu, select Plane Alignment, and select an alignment

option.
Plane Alignmenk B| = Select Plane
v | Professional Mode =i Align Botkom
%= align Top
2 | Align Eront
Assembly :
Iz 1"__ | Align Back.
Languags P5|E|E':t L Align Left
opki N ane ™
i - lign Right
) Ea ckion ] ]
Figure 5-30: ' , Plane Alignment options
: e, _ . .
Toc & | :%‘wt Ll 1 after re-aligning objects on the build tray:
o e e
Selection | | Selection | —— or—
Model Tree ols menu, select Plane Alignment > Select Plane.
[ = @ ayt t 180 degrees on any axis:
Model Tree DjECt.
- @Traﬁ bject menu, select Flip > Flip X/ Flip Y / Flip Z.
[} Slider . . . .
| Pocket Card Halder_shellt e changes to the object’s orientation on any axis:
| Pocket Card Holder_shellz .
__| Pocket Card Holder_shell pject.
| Pocket Card Holder_shell4 .
| Pocket Card Holder_Shells Transform dlalog box.
_| Packet Card Halder_shells Rotate parameters for each axis.
| Pocket Card Holder_shell?
W Pt el e de_Fell | ite an object on the build tray, you can freeze its orientation
not change when you position it automatically ().

Freezing Model

Orientation To freeze an object:

1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click .
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To unfreeze an object:
» Select the object and click (to de-select it).
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Display Options

Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid
(“shaded”) objects.

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

» From the View menu, select WireFrame.

To revert to the shaded view:

» From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

» From the View menu, select Display Bounding Box.

Figure 5-31: Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

» From the View menu, select Display Thickening Box.

To display the
» From the Vi

Figure 5-33:
Box

Tray 3-D

To display objects without the build tray:
» From the View menu, clear (de-select) the Display Tray option.

Screen Layout Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
» On the View flyout toolbar, select Single View, or 4 Views.
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t screen layout.

~ive, top, front and right views.

| tray is “isometric.” You can change the

Tray
Perspective

Tray Positioning

Setting Object
Colors

swerseeme . _wer . ovoowith one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

W

Isometric
=

Figure 5-35: Perspective flyout toolbar
2. Click the icon that represents the desired perspective.

To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:

» Press the mouse wheel while moving the mouse.

To manually rotate the tray:

» Press Alt and press the mouse wheel while moving the mouse.

The color @% on the build tray can indicate how they are printed.
Objet Stu g, you to choose the color display so that you can easily

see the m | Material - 'face Oflabjeitstes Model material

To choos [Fénors are applied on the display:
R Color indicates Model surface
¥ __——tings ribbon, in the Colors group, select one of the

» On the
option /ﬂ}LQ‘éBIH?fhuRﬁa]fes if coating is used
Figure

Colors display options

validation, Objet Studio checks if there is a problem with the stl files or the

%( Before sending a build tray to the printer, or when you perform tray

positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see “Tray Validation” on page 5-51).

5-36
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Loading Large  Very large stl files can be slow to load and may be difficult to manipulate
Files easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The st! file itself
is not changed, and the complete file is sent to the printer.
To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.
Figure 5-37: Options dialog box, Settings tab

2. In the Large Files section, select Load Partial (reduced).

Large File If you need to work with a detailed model that is composed of a large

Manipulation number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed
models.

Figure 5-38: Object displayed without polygon reduction

Figure 5-39: Object displayed with only five percent of its polygons showing
To use polygon reduction:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Display tab.

Options 3]

ippearance | Grid | Maripulate | Display | Settings
] Enable Palygon Freduction

Diigplay while changing wiew

(® Bounding Bax

) Entire Object

Display when static: view

) Bounding Box

(%) Entire Object

Save Polygon Reduction Data
Default

3. Select Enable Polygon Reduction.

Select Polygon Reduction (Percent).
Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being
moved).
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6. Set display options when the object is being moved (Display while
changing view):

* Bounding Box — A box representing the object’s maximum
dimensions is displayed.

* Adaptive Polygon Reduction —Varying degrees of polygon reduction
are applied, as necessary.

* Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog
box.

%( Selecting the Entire Object options cancels polygon reduction.

Object display The display format affects how quickly objects display. For example, if you
options  select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in static
view:

1. Select to display objects:
* With a Bounding Box (see figure 5-40 on page 44)
*  With Adaptive Polygon Reduction (changing view only)
*  With Polygon Reduction (static view only)
* Entire Object
2. Click OK when done.

Zoom Options  While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

» On the ribbon, open the Zoom flyout toolbar and select an option:
Figure 5-40: Zoom flyout toolbar
O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.

O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray.
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Handling Completed Trays

Tray Validation

DOC-07000 Rev. A

After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3-D printer for production. But
before saving the tray, you can check that there would be no problem
producing it. You can also calculate how much material would be
consumed during production and how much time this would take.

Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

To validate that the tray can be printed:

» On the Tray Settings ribbon, in the Build Process group, click .
or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

| @1
Constraints
Colars
Default Color

Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

The validation status appears on the bar at the bottom of the screen.

Walidation succeeded Models: 1

Figure 5-41: Validation details in status bar
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Production
Estimates

Printing the
Tray File

5-40

Objet Studio enables you to calculate the time and material resources
needed for producing trays before sending them to the printer. The time it
takes Objet Studio to make this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current
tray:
» On the Tray Settings ribbon, in the Build Process group, click .

While the estimate is being calculated, a progress bar is displayed —on
the right side of the status bar (at the bottom of the screen).

When Objet Studio finishes calculating the production resources, the
results are displayed.

Figure 5-42: Production resource calculation
You can e-mail objtf files using Microsoft® Office Outlook®.

To e-mail a file:
1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the e-
mail form.

2. Enter the e-mail address and send the file.
When a tray is ready to be printed, it is placed in the Jobs Queue. When the

job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the 3-D printer.

To send the tray to the print queue:
1. On the Tray Settings ribbon, Build Process group, click .

If printing the tray requires more than one model material (Digital
Material mode), the Job Summary dialog box opens.

Job Summary (X

This Job will be printed in Digital Material™

Material and Time Estimates:

Pinting Made Verawhite Consumption VeroCyan Consumption YeraMgnt Consumption Suppart Consumption Build time

Digital Material 136 g 49 4y 48y 02:43

Fine Estimatian

‘ Help | ‘ Build | [ Cancel
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Pinting Made FulCure720 Consury

:@: gua“tdy 1‘5129 Can another model material be used instead of the
igh Spee ] 7
Digital Material 148 g ane you selected:

O ¥es, use any material with similar characteristics.
Fl @ Mo, use OMLY the selected model material.

e | Back | | Buid | |cancel | | Help |
Hel
: - If the build tray file has not

been saved, the Save As dialog box opens for you to save it now.

00 - Connex 3 User Guide

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 51), and the following warning message
appears.

To cancel the Build command so you can correct the problem, click
No.To print the models as they are positioned on the tray, click Yes.The
Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 76.
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Applying Additional Objet Studio Features

Dividing You can use the Split Object feature to produce objects larger than the tray
Objects area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.
To split an object:
1. Select the object.
2. From the Object menu, select Split.

3. In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

Figure 5-43: Split Object dialog box
. In Save to Folder, enter the folder name.
5. Click OK.
The composite parts are saved as new st/ files with “Part 1,” “Part 2,”

etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you
check them for defects in an STL-repair application, such as Magics,
by Materialise.
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Choosing the
Support
Strength

DOC-07000 Rev. A

When producing models, support material fills some hollow and empty
sections (see “Model Orientation” on page 5-32). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a
model:

1.
2.

Select a model on the tray.

On the Model Settings ribbon, in the Options group, click .

or—

¢  On the Model Toolbar, click .

or—

* From the right-click context menu, select Advanced Properties.

The Advanced Properties dialog box opens.

Advanced Properties ﬁ

Grid Style [ ] Hallaw
{*) Standard

) Heawy
) Lite

Apply

In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.

* Standard —for models needing average support (most models).
* Heavy —for large models needing much support.

* Lite—for delicate models needing little support.

Click Apply.
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“Hollow”—
Filling Models
with Support
Material

5-44

Many objects placed on the tray from st/ files are “solid.” This means that,
when printed, the model will be completely filled with model material.
Often, especially with large objects, this is unnecessary. Instead, the model
can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. This feature of
Objet Studio is called “Hollow.” You can set the thickness of the shell —
between 0.015 and 3.825 millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
¢  On the Model Toolbar, click .
or—
* From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties E|
Girid Style Hallaw
(%) Standard
) Heawy Shell Thickness: |1.35
) Lite

3. Set the shell thickness, in millimeters.

4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.

2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.
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Displaying the
Cross Section
of Objects
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The Section feature enables you to view the interior of an object by “slicing”
it on any axis. You can then manipulate the object to inspect the interior
from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 5-59). Displaying an object’s cross section only affects
how the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Section §|

Section l

¥ Enable Clipping

Figure 5-44: Section dialog box

2. Select Enable Clipping.

Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that
you see the cross section you want.

Figure 5-45: Whole view Figure 5-46: Cross-section view, after
using the Z-slider
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Saving the
Screen Display
as an

Image File

5-46

You can save the image displayed in the active viewing screen as a graphic

From the Objet Studio Commands Menu menu, select Save Bitmap.

file.
To save the screen display as an image:
1. DPress Ctrl+B.
or—
The Save Bitmap dialog box opens.
Save Bitmap @
Savein, |D STL Files j Ef( Eg-
2009 G0 Ta Last Folder Visited]
Cz-0148
*Apnlications - Tab Coating.bmp
*Traya.bmp
File name: ‘Applications - Tab Coating
EEVERCLTEA . indows Bitmap [ bmp) Cancel
DataType:  |RGE Twe Color  [24-hit) -
Compression: ‘NDH-CDI‘HDIESSEd j
2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type pull-down menu, and select the file format.
5. Click Save.
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Exporting and
Importing
Objet Build
Trays
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When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Objet printers for
displaying and producing the st! files used on the tray. To conveniently
save all of the files that comprise the build tray, for storing the job, or for
transferring it to another location, Objet Studio compresses them into one
objzf file. To later use the objzf file, the file must first be expanded in Objet
Studio and its component files saved.

Note: If you export an objzf file containing a stl file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the
read-only stl file is saved.

To create an objzf file:

1. From the Objet Studio Commands Menu menu, select Export Packed
Job.

The Save As dialog box opens.

2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:

1. From the Objet Studio Commands Menu menu, select Import Packed
Job.

2. In the Open dialog box, display the appropriate folder and select the
file.

3. In the Browse for Folder dialog box, display the folder in which you
want Objet Studio to expand the compressed file, and click OK.

The objtf file and associated st! files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

Creating a
Quick Access
Toolbar

Hiding the
Ribbon

5-48

* Creating a quick-access toolbar for frequently used commands.
* Changing the position of the Quick Access toolbar.

* Minimizing the ribbon.

* Changing the Objet Studio color theme.

* Configuring default settings for objects placed on the build tray.

As you work with Objet Studio, you may use certain commands frequently.
You can create a quick-access toolbar to make your work easier.

To create a quick-access toolbar:

1.

5.

6.

Above the ribbon tabs, click .

The Customize Quick Access Toolbar menu opens.

Select a command you want to add to the toolbar.

An icon for the selected command is added to the toolbar.
L Tray Setkings Job Mana

B v ¥ 3 S

Insert || Placement Yalidate [Estimate Biuild

Model Build Process

To add another command, repeat the above procedure.
To choose from a wider range of commands:

* From the Customize Quick Access Toolbar menu, select More
Commands.

or—
* Right-click on the Objet Studio Commands icon, or elsewhere on the
ribbon, and select Customize Quick Access Toobar.
Cuskomize Quick Access Toaolbar, ..

Shiowe Quick Access Toolbar Below the Ribbon

Minimize the Ribbon

Figure 5-47: Right-click ribbon menu
The Options dialog box opens.
Figure 5-48: Quick Access Toobar Options dialog box

Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

Select a command and click Add.
Click OK.

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.
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To hide the ribbons:

1. Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands Menu .

2. Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon
icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:
> Repeat the steps above to cancel Minimize the Ribbon.
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Display Colors

5-50

You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Define Colors.
The Define Colors dialog box appears.

2. In the Define Colors dialog box, click the color patch you want to
change:

* Tray Color.
* Background Colors.

e Selection Color.

Chick the color patch you want to change,
and in the dialog box that opens,
gelect a color from the menu,

Tray Calor I:I
Background Caolors I:I I:l
Selection Color I:I

(%) Show Color According to Material
() Color &ccording to Finish

[ Ok l [ Cancel ]

3. In the Color dialog box, select one of the Basic colors.

or—

Click Define Custom Colors to expand the dialog box and allow you to
define a customized color.

Basic colors:

B = e
Hf NN N N
ENNEENEEN
ENEEEENEN
EEEEEENN
EEEENE

Custom colors:

e e | |
e Hus[143] - R |71z

Sat: Greet:
Diefine Custam Colars »» ColorSolid | Blue:

’ QK ] ’ Cancel ] ’ Add to Cuztom Colors ]

4. Click OK when done.

The patch color in the dialog box changes according to your selection.
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Changing Color
Themes

Keyboard
Shortcuts

Setting User
Preferences
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Objet Studio offers a choice of four background color themes—blue, black,
silver and aqua.

Figure 5-49: Background color themes

To change the color theme:

From the Style menu, select one of the options.

You can define shortcut keys for frequently used commands.

To define shortcut keys:

1.

6.

Above the ribbon tabs, click .

The Customize Quick Access Toolbar menu opens.

Select More Commands.

The Options dialog box opens (see figure 5-59 on page 64).
Click Customize.

The Customize Keyboard dialog box appears.

Categories: Cammands:

~
Print Presview Build Properties
Amange Tray Default Properties. ..
Model Settings Exit
Job Manager Export PackedJob...
Import Packed Job...
Job Manager...
 achine Properties w

Current Keys: Press new shartcut key

Hame
Assigned to;
[Unassigned]

Set Accelerator for:

Detault

Description:
Build

Azgign Reset All Cloge

Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.

Current shortcut keys are displayed.

Enter the shortcut key in the Press new shortcut key field, and click
Assign.

If you want to redefine all shortcut keys, click Reset All.

You can change several Objet Studio settings that affect objects placed on
the build tray.

To change default settings:

>

From the Objet Studio Commands Menu, select User Preferences.
Building Style—see “Surface Finish” on page 25.
Grid Style—see “Using a Grid to Position Objects” on page 35.

Application Settings—see “Choosing the Support Strength” on page 59,
and “Freezing Model Orientation” on page 42.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
» Open the Tools menu.

Tools =|style - (@) -

Grid
Snap ko Grid

Constrainks Setkings...

Section

Flane alignment 3

V' | Professional Mode

Language...

Options. ..

Define Colors, ..

If Professional Mode is checked, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

Figure 5-50: Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default You can control the default settings of several Objet Studio features from
Settings the Advanced tab of the Options dialog box.

To display the Options dialog box
» From the Tools menu, select Options.
or—

In the Objet Studio Commands Menu, click Options.

Options g|
Appearance Grid M anipulate Dizplay
Settings Advanced Troublezhooting

[ suto Zoom

Orient Objects dutamatically

[ Ok H Cancel ]

By default, when Objet Studio places objects on the build tray, it orients
them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 28). In any case, when objects
are on the build tray, you can change their orientation manually, if
necessary —see “Model Orientation” on page 32.)

To change the default setting so that Automatic Orientation is disabled:
» In the Advanced section of the Options dialog box, clear the check box.

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 50).
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Open GL
Driver
Configuration

The OpenGL driver displays 3-D graphics on your screen. There is
normally no reason to adjust its settings. If you suspect a problem with the
way Objet Studio displays objects, you can use the OpenGL Driver
Configuration tool to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:

1.

From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.

In the Options dialog box, display the Troubleshooting tab.

Options g|
Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

OpenGL Driver Configuration. ..

(] 8 ] [ Cancel

active (see Professional Mode Features).

%( The Troubleshooting tab is only accessible when Professional Mode is

5-54

3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.

X

OpenGL Driver Configuration

Window Pixel Format | Memony Pixel Format | Advanced

() Pixel Format D
(¥ Choose Format | Option 1 v
Color Bits 24
[epth Bits 32
Alpha Bits 0
[ Ok ] [ Cancel ]

Figure 5-51: OpenGL Driver Configuration dialog box

If you want to display the values and change them, click . Alternately,
you can select Choose Format and change the values in this dialog box.
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To perform a test of the driver configuration and enter the suggested
pixel format ID:

1.
2.

Select Choose Format.
Click Test.
Objet Studio returns the recommended pixel format ID.

Objet Studio x|

-
\lr) Choose Pixel Format: 5

Figure 5-52: Recommended pixel format ID

Click OK.

In the OpenGL Driver Configuration dialog box, select Pixel Format ID
and enter this number.

Click Apply.
Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen information, as you work.

To view Objet Studio Help:
* DPressF1.
or—

On the standard toolbar, click and then click Objet Studio Help.

t v Tools - Stvle - @)~

Ohjet Skudio Help

Troubleshooting
Direct Printing Plug-In
Check for Updates

@ about..,

Figure 5-53: Help options
You can also view information on the following subjects:

* Troubleshooting opens a list of error messages and their
explanations.

* Direct Printing Plug-in opens information on additional software
programs that extend the capabilities of Objet Studio.

* Check for Updates checks if you are using the latest Objet Studio
version.

About Objet Studio

About Objet Studio provides details of your installed version, material
modules and your Objet Studio license information.

To view About Objet Studio:
* Press F1.
or—

On the standard toolbar, click "ﬁ-[' and then click About....

t o~ Tools = Skywle - -.@I ™

Ohijet Studio Help

Troubleshooking
Direct Printing Plug-In

heck for Updates

@ about...

Figure 5-54: About...
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About Objet
Studio

Materials
Module
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The About Objet Studio tab shows your Objet Studio version number,
Objet’s support email address and basic information about your computer.

° e N

About Objet Studio | M aterials Module I Feature Iicense|

(IBJET

Obijet Studio Ver, 9.2.3.0

Copyright € 1998-2012 Objet Geometries Ltd,
All rights rezerved.

For Applications Support:

Operating System:

Applications@2objet. com

Professional -Service Pack 1 [Build 7601)-

Processar Pentium [+
Available Phyzical Memory: 1364 MB
System Resources: 7 %

Figure 5-55: About Objet Studio

The Materials Module tab shows:

1. Module version—the latest patch installed. If there are no patches
installed, the module version is the same as the Objet Studio version

number.

2. Module date—the date of the latest patch was created. If there are no
patches installed, the module date is the date of the current Objet

Studio version.

3. Module properties—a description of the patch. If there are no patches
installed, the module properties value is “Default”.

° e N

About Objet Studio | Material: Module | Feature licenze

Module version:  9.2.30
Module Date: 28.06.2012

Module Properties: Default

Figure 5-56: Materials Module
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Feature The Feature License tab shows the Objet Studio features for which you are
License licensed.
Click # to expand the license details for each feature.
o ]

[ About Dbjet Studio [ Materials Moduls | Feature license |

igital M aterialz
[ Mixed trap

Figure 5-57: Feature License

Modes

Modes shows the printing modes for which your version of Objet Studio is
licensed, such as High Speed, High Quality and Digital Material.

%{ Available modes may vary, depending on your printer model.

Materials

Materials shows the names of all parent materials for which your version of
Objet Studio is licensed. For example, FullCure720, VeroBlack and
VeroGrey.

% Available materials may vary, depending on your printer model.

Digital Materials

Digital Materials shows the names of all digital materials for which your
version of Objet Studio is licensed.

%{ Available digital materials may vary, depending on your printer model.

Mixed Tray

Mixed Tray shows whether your license allows for printing a mixed tray. A
mixed tray is a build tray containing objects, each of which is designed to
be printed using a different model material.
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Monitoring and Managing Print Jobs

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3-D
printer —the server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3-D printer server from that computer, and it
allows the user to edit only these jobs.

Note: If there are several Objet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific
3-D printer (server), displays the queue and status for all jobs sent to
that 3-D printer by the server and by all client computers on the
network. It also allows editing and manipulation of all jobs, and enables
re-sending previously-printed jobs to the printer.

prepare tray files for any Objet printer. Later, these files can be used by

%( If Objet Studio is not connected to a printer (or printer server), you can

Objet Studio on the appropriate printer server.

Job Manager
Screen

DOC-07000 Rev. A

The Job Manager screen on the client and server workstations looks
identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.

Figure 5-58: Job Manager screen

The Job Manager screen is divided into panels:
* Jobs Queue

* Print Time

* History

* Available Resources

* Material Consumption

¢ Tray Preview

* Waste
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Jobs Queue

Print Time

History

Available
Resources

Material
Consumption

Tray Preview

Waste

On the server, the Jobs Queue lists the last 15 jobs sent from client
computers. On client workstations, the Jobs Queue lists jobs sent from that
computer to the printer server.

Information for each of the queued jobs is displayed, including the job
status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be

continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing  The 3-D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting
position, UV lamp turned on, and the build tray level is
adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
* Owner—the computer that sent the job.
* Build Time—the estimated building time for the job.

* Model Consumption—the amount of model material required to
complete the job, and the amount actually used till now.

*  Support Consumption—the amount of support material required to
complete the job, and the amount actually used till now.

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Available Resources panel contains graphic indicators that show the
amount of available printing material remaining.

¢ Actual —the amount of material used till now
* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 87).

If you move the mouse over the Waste display, the amount of waste in the
container is displayed.
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Setting the
Printer
Connection

When an Objet 3-D printer is installed, the server computer is connected to
that printer. Normally, there should be no reason to change this connection.
Occasionally, however, you may need to reset the connection, to connect
the server to another printer, or to use Objet Studio in off-line mode

(without a printer connection).

To set (or change) the printer connection:
1. On the Job Manager ribbon, in the 3D Printer group, click .

2. Inthe Set Printer dialog box, click Connect.
Set Printer @

Frinters:

- Dbjet260Dental -
- ObjetG000ental
Obijetline

Printer Connection

= =
=

Enter printer name/IP address.

Unknown Browse..

Use ‘Unknown' for off-line mods.

[=)- Objeta00
C |
om0 Eden

its IP address, or click Browse to find and

Click OK.

When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

Objet Studio is connected to the printer if you can see the material levels in
the Job Manager screen.

DOC-07000 Rev. A
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Off-line Mode  You can use Objet Studio to prepare trays for printing in off-line mode, on
aremote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.

To disconnect Objet Studio from the printer:
1. On the Job Manager ribbon, in the 3D Printer group, click .
2. Inthe Set Printer dialog box, click Connect.

Set Printer (=]
Frinters:
- Dbjet260Dental -
- ObjetG000ental
Obijetline
'
| \ 3
!'{ij ==
S

Figure 5-59: Disconnecting Objet Studio from a printer (A)
3. Printer Connection dialog box, delete the computer name/IP address.
Figure 5-60: Disconnecting Objet Studio from a printer (B)
4. Click OK.
“Unknown” appears in the printer-name field.
Click OK.

In the pop-up message, confirm that you want to work in off-line mode
by clicking No.

M Job Manager

y Ohijet Studio is in off-line mode.

Do wou want ko connect ko a 30 prinker?

When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.
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To change the Objet Studio off-line configuration:

1.

Set Printer

Frinters:

- Objet2600ental
- Dbjet500Dental
Obijetline
Obijet500

- Objet500 Eden
Objeth00 Eden Pro
Objeth00 Connexs
Objeth00 Connex3
Objets00 Color
i Objet500 Dent

Printers:

Connex260
Connex350
Connexb00
Eden 2600
Eden 3500
Eden 5000
Objet1000
Objerz24
Objet2600ental
Objeta0

|

£

2. Click OK.

In the Set Printer dialog box, select a printer type.
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Setting the
Remote Printer
Connection
(Client Mode)

Job Manager
Commands

5-64

When you open Objet Studio for the first time in a client installation, you

are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1.
2.

The Job Manager ribbon has three icon groups:

On the Job Manager ribbon, in the 3D Printer group, click .

Enter the name of the server computer or its IP address, or click

Browse to find and select it.
Click OK.

Specify Server Computer name/|F address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-61: Printer Server Connection dialog box

* 3D Printer
* Queue
* Job

Figure 5-62: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
you cannot stop printing a job that is not being printed, so the Stop
command is disabled.
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The following operations are available on the Job Manager ribbon:

Group Icon

Purpose

3D
Printer

Client: Sets the server connection. See “Setting the Remote
Printer Connection (Client Mode)” on page 82.

Server: Sets the printer connection. See “Setting the Printer
Connection” on page 78.

Configures options for printer alerts. See “Configuring User
Alerts” on page 85.

Queue

Server: Moves a job to the head of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 77.

Server: Moves a job to a higher position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 77.

Server: Moves a job to the bottom of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 77.

Server: Moves a job to a lower position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 77.

Job

Server:

* For ajob in the Jobs Quene—Prints it again (from the
beginning).

* For ajob in the History list—Moves it to the Jobs Queue
for printing.

Client: Disabled.

See “Restarting Jobs” on page 88.

©

Skop

Server: Stops a job in progress.
Client: Disabled.

Server: Continues printing the current job from the point
where printing stopped.

Client: Disabled.
See “Resuming Jobs” on page 88.

Removes the selected job from the queue.

Refreshes the image of the selected job in the Tray Preview
display.

Opens the Traﬁ Settings screen and displays the tray. For
deleted jobs, this enables you to make changes before
printing.

In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Figure 5-63: Icons on pop-up toolbar (server)
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Figure 5-64: Icons on pop-up toolbar (client workstation)

When you position the cursor over an item, a tooltip displays the name of
the command.

Job =\ Tools = Skyle -

% Skop...

¥ Delete 1ok,

Show 3dProgress

. Export ...

Figure 5-65: Job menu options (server)
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Configuring
User Alerts
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.
* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.

Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

1. On the Job Manager ribbon, in the 3D Printer group, click .

Sound Alert
@ () Voics Messages (3 PE Speaker
Z

Fieport to Printer

HP Desk.let 330C/932C/335C

Add Recipient.

Remove Recipient

Add Recipient

Fieport to e-mail

[] Riepot via SMS

Q RemindMe 15min | Before Cartridges Emply

Q RemindMe 100g | Befors Cartridges Empty
oK. Cancel

Figure 5-66: Notifications dialog box (server)

Notifications @

Sound Alert
@ @) Voice Messages ) PE Speaker
2

[ Report to printer

Fieport to e-mail
#dd Recipient
Remove Recipint

[ Report via SMS

Figure 5-67: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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3. Click Details.
Select Events to report on:

Successful job finish
Job interruption

End af Material reminder

l Ok ] [ Cancel ]

Figure 5-68: Event selection for alerts

4. Inthe Reports Events dialog box, select the alert events and click OK.
5. In the Notifications dialog box, click OK.
Printing the If there is a job in the Jobs Queue, it is sent automatically to the Objet

Tray printer—as long as it is on, there is a connection to the printer, and the
printer is on line.

Additional Object Studio on the printer servers includes the following additional
Server features:
Features .

Extended Tray Preview

* Editing Jobs

* Restarting Jobs

* Resuming Jobs

* Scheduling Jobs

* Exporting Jobs (objzf)

* Modifying the Job Manager Screen
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Extended Tra

In this window
magnifications
displaying the
enlarged build

To display the

1. Select a job
2. Click the Tr

Figure 5-69: R=a
Job Preview

* To change the tray magnification, turn the mouse wheel.
* To view the tray from a different perspective, click the relevant icon.
* To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you don’t want to print.
2. Display the Build tab.
3. Select Exclude from Build.

Figure 5-70: Excluding a model from the build
4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.

To display printing progress in the Tray Preview pane:
» From the Job menu, select Show 3dProgress.

%{ This option uses additional system resources.

Editing Jobs

You can open jobs in the Jobs Queue for editing.
To edit a job:

1. Select the job.

2. Click the Edit icon .

The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. [Edit the job.
On the Tray Settings ribbon, click .

The status of the job in the Job Manager screen changes back to
“Waiting.”
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Restarting Jobs

You can restart jobs from the Jobs Queue and the History list.

To restart a job:

1. Select the job.

2. Click the Restart icon .

The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job.
2. Click the Resume icon .

Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select a job in the Jobs Queue, and click on the pop-up toolbar.
2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.
f g

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
B apiizonn 3

Sun Mon Tue Wed Thu Fri Sat|-=
12 3

4 5 B 7 8 3 10
[ 12 13 14 15 16 17
18019 20 21 22 23 24
28 26 2 28 23 10 J

—2 Today: 4/11/2010

Figure 5-71: Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

For an explanation of objzf files, see “Exporting and Importing Objet Build
Trays” on page 63.

To export a print job:

1. Select ajob.

2. On the pop-up toolbar, click .

3. Inthe Save As dialog box, select a folder.
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4. Click Save.

Modifying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel
* the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

* (lick again to display the panel.
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Printer cover

@yisoy |

Storage
compartment

Materials
cabinet

Figure 6-1: The Objet500 - Connex 3 3-D Printer

Starting the Printer

& CAUTION!

* Do not attempt to operate the Objet printer before being trained by an
Objet customer-support representative.

* Observe all safety warnings and follow the safety guidelines described
in chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power cable and switch

The main power switch turns on the Objet printer, which includes the
built-in computer.
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Printer mode

Current activity.

R

DOC-07000 Rev. A

2. After the computer boots, log in to Windows and launch the printer-
control application:

*  On the computer desktop, double-click the Objet printer icon.
or—
* From the Start menu, select Objet > Objet500.

The Objet printer interface screen opens (see figure 6-2). All monitoring
and controlling of the printer is done from this interface.

16 Oct2012  19:14

VeroBlue

M-3R

VeroBlack

Model material

.% cartridges

1
‘ 400 gr
)
\

M-2R

M-1L M-1R
Previous job last slice: 0

400 gr 400 gr

Support material
cartridges

Fullcure705 Fullcure705

Display
toggle button

Online/offline
button

Pause button

Figure 6-3: Objet500 - Connex 3 interface

Objet installations utilize one monitor for displaying both the computer
running Objet Studio and the computer installed inside the printer. Make
sure that the KVM (keyboard-video-mouse) switch is in the correct position
so that the printer interface is displayed.
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Loading Model and Support Cartridges

=

Objet500 - Connex 3 printers use six cartridges of model material and two
cartridges of support material, each weighing 3.6 kilograms when full. A
graphical representation of the cartridges loaded and their current weight
appears in the printer interface (see figure 6-3).

The materials cabinet uses RFID technology to automatically identify
cartridges of printing material. For this purpose, an RFID module is built into
the cabinet. Tampering with this module will render the printer inoperable
and may void Objet warranties and service contracts.

Important: If you need to replace the model material currently
installed with another type, see “Changing the Model Material”
on page 6-11. Otherwise, make sure to replace the model
cartridge with one containing the same type of material.

To load model and support cartridges:

1. Open the door of the materials cabinet.

2. If you are replacing a cartridge, grasp its handle and pull the cartridge
out, taking care not to twist or turn it.

3. Load model and support cartridges into their respective
compartments.

You should feel some resistance, as a needle pierces the cartridge.

4. Check the printer interface to make sure that the new cartridge is
detected and that its weight is displayed (see figure 6-3).

5. Close the materials cabinet.

Tips about replacing cartridges:

* You can replace material cartridges either before or during printing.

* If printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens,
see “Resuming Production After Printing has Stopped” on page 9.

* You can replace partially used cartridges to avoid the need for replacing
them during printing.

* You can load partially used cartridges, as long as they contain more
than 100 grams of material.
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Producing Models

3

A
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The Objet500 - Connex 3 printer produces models by printing tray files
prepared in the Objet Studio application and sent to the printer from there.
For information about preparing model files for printing, see “Using Objet
Studio” or Objet Studio Help.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
“Pattern Test” on page 20).

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not,
remove old material with the scraper, and clean the tray thoroughly
with cleaning fluid.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2. Make sure that there is sufficient model and support material loaded,
as indicated in the printer interface (see figure 6-2). You may want to
replace the cartridges of model and support material currently loaded
in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 6-4.

For changing the type of model material currently loaded, see
“Changing the Model Material” on page 11.

3. At the bottom of the printer interface, click the red button to switch the
printer to online mode.

The color of the button changes from red to green (see figure 6-3). If
there is a job in the Job Manager queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

* The print block is heated.
* The UV lamps are powered and they warm up.

When printing begins, Objet Studio sends seven slices to the printer. This is
the standard buffer between Objet Studio and the printer. As each slice is
printed, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough model
and support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Objet printer. Do not log-off Windows until printing is
finished.
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The Objet500 - Connex 3 printer uses one or more model-material
cartridges and one support-material cartridge to produce models. If
additional cartridges are installed and they are not needed for the current
print job, the printer interface indicates which are being used:

* Blue cartridge—used for the print job
* Gray cartridge—not used for the print job

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface

screen.

mET 16 Oct 2012 19:14

Temperature
. behind Heads (°C)
print block

J Temp. of each
model head

Temp. of each
support head

Temperature.
in front of

print block
Waste Weight— Waste (ar) Heads Liquid Support/ModeI
. material in print-
Chamber temp. — ambient(°C) ECRD Heads vacuum block reser\F/)oir
Left UV lamp— wiamps M) BEYR Pre Heater Front 72 ~—_System

Pre Heater Rear vacuum level

Temp. of material
pre-heaters

Right UV lamp—

Display
toggle button

Printer set to
online mode
(green)

Figure 6-4: Printer indicators
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Printer
Interface
Color Key
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

* Green—suitable/ready for printing
For example, in figure 6-3:

O Heads (°C)—The heads have reached the temperature required for
printing models.

0O Ambient—The ambient temperature of the printing chamber is
within the acceptable range.

O Heads Liquid—The level of model and support material in the print-
block reservoir is OK.

O Vacuum—The vacuum level in the system is within the acceptable
range.

* Red—not suitable for printing (or indicates a warning)
For example, in figure 6-3:

O Waste—The weight of the waste container is 9000 grams, more than
allowed when beginning a print job. (See “Replacing the Waste
Container” on page 6-36.)

* Blue—not ready
For example, in figure 6-3:
0 UV lamp—The UV lamps are not on.

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

* Blue—active cartridges

* Gray—reserve cartridges

6-7
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Printing
Indicators

Printer mode

\
Job information
\

Current Activity:

Job information «=

Stop button

The printer interface screen changes when you send a print job from Objet
Studio to the printer, and the printer is on line (see figure 6-4):

The mode changes from Pre-print to Printing.

The specific activity being performed is shown in the “current activity”

field.

Current job-printing information is displayed.

The printing progress bar is displayed.

The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

Figure 6-5: Printer interface during printing

M-3L

Print Time 00:20:01 400 gr
VeroBlack

Height 4.73mm of 28.37mm
M-2L

Printing Pass 1
400 gr

Slice 163 of 1013 (16.1%) Tl

M-1L
Previous job last slice: 163

400 gr
FullCure705

SL

16 Oct 2012

400 gr
VeroBlack

M-2R

400 gr
VeroWhite

M-1R

400 gr
FullCure705

SR

OBJET 500

Progress bar

Pause button
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Resuming Production After Printing has Stopped

3
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If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don't replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

After printing stops, the printer goes into Standby mode, when heating of
print heads is reduced. About 10 hours later, the printer goes into Idle mode,
when heating of print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see figure 6-2 on
page 6-3).

The button changes from red to green (see figure 6-3 on page 6-6).

2. If you don’t know why printing has stopped, make sure that the

connection between the printer and the server computer is active.

In the Job Manager screen of Objet Studio, click the Resume icon e

Resume

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

Printer mode Standby 1

Print Time 00:20:01

Height 4.73mm of 29.37mm

Printing Pass 1

Last slice printed Slice 168 of 1013 (16.1%)

Figure 6-6: Printer interface after interrupted printing

Continue from Slice: |§|

163

Ok | Cancel |

Figure 6-7: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.

You cannot continue printing the model if:

* The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

* There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a

6-9
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printing stoppage on a model depend on the model size and structure,
model material used, ambient temperature and the length of the

stoppage.
If you cannot continue printing:
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Send the job to the printer again.

from the Job Manager screen of Objet Studio, since both applications are
updated when you use these commands. However, after clicking the Pause

button in the printer interface, you can only resume printing from the printer
interface.

%( You can stop and later resume printing from either the printer interface or
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Changing the Model Material

=
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Before producing models using a different type of model material than is
currently installed, run the Material Replacement Wizard to flush the print
block and feed tubes.

You should carefully plan printing models with different model materials to
avoid unnecessary waste of material currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are
replacing one or more materials.

The Material Replacement Wizard suggests the best slot locations for
placing different material cartridges, based on materials in the system. This
ensures minimum flushing of materials currently loaded.

To replace the model material:

1. Start the Material Replacement Wizard from the Options menu.

File” Options Help

Go to Tray Upper Position

Go to Purge Position 16 Oct 2012 19:46
Wipe

Go To Head Inspection

Purge Sequence

Pattern Test
Wizards Material Replacement

Built In Tests... Ctri+ Alt-B Wiper Cleaning

Maintenance Counters... Head Cleaning
Collect Service Data 2] UV Calibeation (GE(R)
UV Lamp Replacement

Head Alignment
Head Optimization

Waste (gr) z:aad(eu Calibration
utdown

Ambient(°C) “ Heads Vacuum 0
UV Lamps n n Pre Heater Front

Pre Heater Rear

OBJET 500

Figure 6-8: Starting the Material Replacement Wizard from the Options menu

2. In the opening screen, click Next
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6-12

3.

If the printer cover is not closed, a screen appears instructing you to
close the cover. Confirm that it is closed and click Next.

Material Replacement Options

Printing mode
(©) Single material printing mode (HQ, HS)

@ Multiple materials printing mode (DM)

Required materials
l Mote: Cartidge positioning in material cabinet is determined automatically.

’\u"eroWhite w7 ] "u"eroBIack w7 ] "u"eroBIue w7
[¥] Both cartridges [¥] Both cartridges [¥] Both cartridges
Flushing cycle

@ Full @ Full @ Full

(©) Economy (©) Economy (©) Economy

'Full' provides you with exact color immediately.
'Economy’ enables a faster material replacement cycle.

’ ? Help ] ’Advanced Settings...]

Figure 6-9: Material Replacement Options

In the Material Replacement Options screen, you select the settings that
determine how the wizard replaces material currently in the system
with newly loaded material.

Choose whether you want to produce models in Single Material mode
or in Digital Material (“multiple-materials”) mode.

Single Material mode

Four print heads are used to print, using one model material.

O This mode is required to produce build trays with the High Quality
setting, and to produce trays with the High Speed setting using only
one model material.

Digital Material mode
Each of the model materials loaded is used in two of the print heads.

O If only one of the model materials is required for printing, models
are produced using two print heads. This makes it unnecessary to
replace the other model material.

O If model-material substitution is allowed, the printer produces trays
with the High Speed setting using a mixture of model materials (see
“Model Material Substitution” on page 5-112).

In the Required materials section of the wizard screen, select one or more
replacement materials.
Select Both cartridges if you need to load two replacement cartridges.

Loading one replacement cartridge (if sufficient) is more economical
because it potentially requires less flushing of material currently in the
system.

DOC-07000 Rev. A
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7.

In the Flushing cycle section of the wizard screen, choose how
thoroughly you want to flush out material currently in the system.

*  Economy. This cycle can be used when replacing a light-colored
model material with a darker material (such as TangoBlack™ or
VeroBlack™), or if the exact color of the printed models is
unimportant.

The wizard flushes the system with the minimum amount of
material needed to ensure that models have the mechanical
properties of the new material.

* Full. Use this cycle when the printed models must have the exact
color of the new material.

The wizard thoroughly flushes the feed tubes and print heads
needed for printing, based on your selections in the previous
screens.

Advanced Settings

Cartridge positioning:
@ Automatic slot selection (Recommended)
(2 Manual slot selection |

This selection applies to this use of the wizard only.

Select material most used in Single material mode (optional):

OBJE T [C]*Flush again” options

() (23]

Figure 6-10: Advanced Replacement settings

Material Replacement Wiza

Cartridge positioning and process progression

Insert the new material cartridge as shown below, and click Start.

L R

Left Right
M3 VeroBlue VeroBlue
: M2 VeroBlack VeroBlack
M1 VeroWhite VeroWhite
Suppat FullCure705

Start...

Replacement progress
| 0% |
OsjeT This process will take approximately 2 minutes.

’ x Lancel ] ’{ Erevious] Hest §>

Figure 6-11: Cartridge insertion
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8. When the final wizard screen appears, make sure that the screen
displays the newly-loaded material(s). Click Done to close the wizard.

Material replacement completed

L R
PFrinter's current configuration
Left Right
M3 VeroBlue VeroBlue
M2 VeroBlack VeroBlack
M1 VeroWhite VeroWhite
Suppart FullCure705 FullCure705

Printing mode: Digital materials (DM)

ET
Ce Important: After closing this wizard, clean the area around the purge unit.

Figure 6-12: Results of material replacement

& CAUTION: Dispose of all material cartridges in accordance with all
applicable laws and regulations. If necessary, the cartridges can be

disassembled for recycling. If this is done, protect the person handling
the cartridges from direct exposure to uncured resins.

The printer-control interface is automatically updated, and should
display the new material(s). The Objet Studio interface (on the printer-

server workstation) is also updated.

DOC-07000 Rev. A
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Keeping the Printer in Idle Mode

=
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Between printing jobs, the Objet500 - Connex 3 printer can be kept on for up
to one week. If the printer will not be used for more than a week, use the
Shutdown Wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).

When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Time after printing | Mode Change in heating of print heads
first 15 minutes Standby 1 none

next 10 hours Standby 2 heating reduced (to room temp.)
after 10 hours Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 6-2, 6-3 and 6-4 on pages 3, 6 and 8).

If, after printing a job, you know that the printer will not be used for 10
hours or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:

» From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Objet printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—uwith the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown Wwizard (see below).
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Shutting Down the Printer

6-16

You only need to shut down the Objet printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode. To
properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown Wizard. Do not attempt to shut down the
printer by simply closing the computer interface (the printer-control
application), and never disconnect power to the printer before
completing this wizard.

Depending on the length of time the printer will not be used, you can
choose between a short shutdown procedure, and a more thorough
procedure.

* Up to 10 days: The wizard empties the print block of model and
support material, to prevent leaks. This takes about 10 minutes.

* More than 10 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 35 minutes, and you
must be present to load cleaning-fluid cartridges when instructed.

To run the Shutdown Wizard:

1. Select Shutdown from the Options menu, or press F8.

Shutdown Wizard

= N Shutdown Wizard

This wizard controls the processes necessary for shutting
down the printer.
Fress 'Next' to continue or 'Cancel' to quit.

Figure 6-13: Shutdown Wizard, opening dialog box

In the opening wizard screen, click Next.

3. Choose the appropriate option for the length of time that the printer
will not be used —less or more than ten days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

4. In the next screen, verify that the tray is empty and click Next.
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The shutdown procedure begins.

Shutdown Wizard

L Shutdown in Progress
ShutDown
i 00: 02

Osjer

Figure 6-14: Shutdown progress screen

5. When the final wizard screen appears, close the printer-control
application and shut down the built-in computer.

Shutdown Wizard

N Shutdown Procedure Completed
You may now shut down the printer computer and turn off
power to the printer,

Oegjer

Figure 6-15: Final Shutdown Wizard screen

6. After the printer computer shuts down, turn off the main power switch
at the back of the printer (see figure 6-2 on page 6-2).
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Maintaining the Printer

The performance of routine maintenance tasks is essential for getting
satisfactory results from Objet 3-D printers. Perform the tasks at specified
intervals for optimum performance.

Routine
Maintenance
Schedule

6-18

printing (A reminder
message appears.)

Frequency Task For More Information
Daily, before printing Clean the print heads. See “Cleaning the Print
Heads” on page 6-18.
Weekly Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 6-20.
Weekly Clean and inspect the See “(see “Replacing
wiper. Print Heads” on
page 6-139)Cleaning
and Replacing the
Wiper” on page 6-22.
Weekly Restart the printer
computer and the
server compulter.
Weekly Clean the roller waste | See “Cleaning the Roller
collector. Waste Collector and
Inspecting the Roller
Scraper” on page 6-24.
Every 300 hours of Test the UV lamps. See “Testing and

Calibrating the UV
Lamps” on page 190.

printing, or once a year

Monthly, and after Check the alignment of | See “Aligning the Print
replacing print heads the print heads. Heads” on page 6-29.
Monthly Calibrate the load cells. | See “Calibrating the
Load Cells” on
page 6-36.
Monthly Inspect the exhaust
system (duct, fan,
connections).
Every 2000 hours of Preventive maintenance | Contact your Objet

visit by authorized
service engineer.

support center.
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Cleaning the Periodic inspection and cleaning of the orifice plates on the bottom of the
Print Heads print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. This procedure takes about 20 minutes, and
should be done at the beginning of the work day or before a big printing
job.
To clean the print heads:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* an Objet-supplied cleaning cloth or equivalent
® amirror

2. Start the Head Cleaning Wizard from the Options menuof the printer
interface (see figure 6-22 on page 6-22).

3. Follow the instructions on the wizard screens, and select the check
boxes to confirm that:

* you have checked that the tray is empty.

* you have closed the cover.

Clean Heads Wizard Pz|
Clean Heads Wizard
Flease check if the tray is empty and close the
doar.
|
[v Tray iz empty
(@51
XK Cancel | =Z | Mext 3= |

Figure 6-16: Head cleaning procedure—wizard screen

4. Click Next.

The printer prepares for you to clean the print heads.
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5. When the following screen appears, open the cover.

Clean Heads Wizard Pz|
. Are heads clean ?
Caution:

Heads i |!E Flease open the door and clean heads.

are Hot! 4&3
[~ Heads: clean
Cajer
A

Figure 6-17: Head cleaning wizard—steps 5-10

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Place the mirror on the build tray.
Put on the gloves.
Soak the cleaning cloth with the cleaning fluid.

o *® N

Clean the orifice plates, with a back-and-forth motion (see figure 6-17).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-18: Cleaning the heads

It is recommended that you use this opportunity to also clean the roller and
the UV lamps.

10. When you have finished cleaning, select the confirmation check box in
the wizard screen (see figure 6-16) and click Next.

6-20 DOC-07000 Rev. A



Objet500 - Connex 3 User Guide

Pattern Test
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11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click

Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Clean Heads Wizard fgl

Heads clean wizard completed

©OBJET

| =Z | JDonel

Figure 6-19: Head-cleaning wizard—final screen

13. Click Done to close the wizard.

The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:

1.

2.
3.
4

Make sure that the build tray is empty.

Prepare a sheet of pink paper —A-4 or Letter size.

In the printer, tape the pink paper to the surface left of the build tray.
Press F3, or open the Options menu and select Pattern Test.

9 Perform Pattern Test?
\_‘

Figure 6-20: Pattern Test confirmation

If the build tray is not clear, click No in the following dialog box.

This lowers the build tray, so that models on the tray are not damaged.

9, Is the build tray dear?
\._f/ (If you dick 'NO', the tray will be lowered.)

Figure 6-21: Build tray (Z) level adjustment

The printer prints a series of lines on the test paper (see next figure).
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Improving
Print Quality

6-22

Figure 6-22: Sample Pattern Test

6. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test” on page 6-20). If the results are poor, use the following

procedure to improve print quality.

If the results of the last pattern test are poor:

1. From the Options menu, select Execute Purge Sequence, or press F4.

2. In the confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the

wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see “Cleaning the Print Heads” on

page 6-18).
2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue

left on them.
2. Perform the purge sequence.

3. Perform the pattern test.
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If the results of the pattern test are still poor:
» Optimize the print heads and replace faulty print heads, if necessary
(see “Calibrating Print Heads” on page 6-33).

Cleaning and A rubber wiper removes excess material from the print heads after the
Replacing the  purge sequence. This is done automatically before each print job, and
Wiper performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.
To inspect and clean the wiper:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* an Objet-supplied cleaning cloth or equivalent
® aspare wiper

2. Start the Wiper Cleaning Wizard from the Options menu.

File Optians Help
Go to Tray Upper Position
Go to Purge Position 16 0ct2012  19:46
Wipe
Go To Head Inspection

Purge Sequence
Pattern Test

Wizards Material Replacement

Built In Tests... Ctri+Alt+B Wiper Cleaning

Maintenance Counters... Head Clearing

Collect Service Data 7] UV Calibeation (G&R)

UV Lamp Replacemen t

Head Alignment
Head Optimization

Waste (gr) E:add&" Calibration
utdown

Ambient(°C) “ [ CECENECTT 0

Pre Heater Rear

OBJET 500

Figure 6-23: Starting the Wiper Cleaning Wizard

3. Close the printer cover, and click Next in the wizard screen.

4. Make sure that the build tray is empty, and close the printer cover.
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Confirm this in the wizard screen.

Inspect the build tray

Confirm before continuing:

Build tray is clearlempty] and the cover iz closed.

Figure 6-24: Wiper Cleaning procedure—step 4
5. Click Next.

6. When the following screen appears, open the cover.

Wiper Cleaning leard

Inspect the wiper
Confirm before continuing:
[ The wiper blade iz clean.
6

Figure 6-25: Wiper Cleaning Wizard during steps 7-10

Put on the cleaning gloves.

8. Using a generous amount of cleaning fluid and the cleaning cloth,
remove any material remaining on the wiper and the surrounding
area.

9. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

10. In the wizard screen (see figure 6-24), confirm that the wiper blade is
clean, and click Next.

11. Make sure that you have removed all tools and cleaning materials
from the printer, and close the cover.
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Cleaning the
Roller Waste
Collector and
Inspecting the
Roller Scraper
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12. Confirm that the tray is clear and that the cover is close, and click Next.

Wiper Cleaning Wizard

13. Click Done to close the wizard.

Confirm before continuing:

Build tray is clearlempty] and the cover iz closed.

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.

This

assembly should be cleaned weekly to prevent a blockage in the tubes

leading to the waste container, so that waste material does not overflow
into the printer.

To clean the roller waste collector:
1. Prepare—
* M2.5 and M2 Allen keys

disposable cleaning gloves
isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
cleaning cloth

cotton swabs (Q—tips® or similar)

2. Put on the gloves.
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3. Remove the right UV-lamp assembly:
a. Disconnect the UV power cable and the fan power cable.

Fan power
-connector

Power connector

Figure 6-26: Disconnecting the right UV assembly

b. Remove the screw attaching the right UV lamp to the print block,
and then pull and lift up the UV lamp.

4. Loosen the two screws securing the suction tube on the print block.

uction tube screws

Figure 6-27: Lifting the suction tube

5. Lift the suction tube to secure it in a raised position.
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6. Remove the two screws securing the covering of the roller waste

collector and remove it.

Be very careful to save the covering screws. These are special screws; if
they are lost you need to order replacements.

Roller waste
collector screws

Figure 6-28: Removing the roller waste collector covering

Remove the covering by pulling it out, and then lower it.

Clean the roller waste collector and the scraper blade surface using
cotton swabs. Make sure to remove any remaining printing materials.

Figure 6-29: Cleaning the roller waste collector

Before replacing the covering you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:

Ll

Put on the cleaning gloves.
Wet a cloth with isopropanol.
Use the cloth to wet the bottom of the roller.

Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of
the blade.

Inspect the roller. If it is not dry, replace the blade. (See “Replacing the
Roller Scraper” on page 6-27.)
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Replacing the
Roller Scraper

6-28
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6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Roller waste
collector pins

Figure 6-30: Roller waste collector pins

7. Return the roller waste collector to the print block and screw on the
covering (see figure 6-27 on page 6-26).

8. Loosen the screws securing the suction tube.

Securing screws

Figure 6-31: Suction tube correctly positioned

9. Lower it so that the hole in the panel behind the suction tube is visible,
and tighten the screws to secure the tube.

10. Attach the right-UV-lamp assembly to the print block and reconnect
the UV power and fan cables.

You should replace the roller scraper blade:

* after 1,000 hours of printing.

* if it does not effectively keep the roller clean.

You should periodically test the effectiveness of the roller scraper when you
clean the roller waste collector. See “Cleaning the Roller Waste Collector
and Inspecting the Roller Scraper” on page 24..

To replace the roller scraper:

1. Prepare—
* anew roller scraper (knife) (KIT-01026-S)
* a Phillips 1x75 mm screwdriver
* M2.5 and M2 Allen keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 6-25.)
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3. Loosen the two screws securing the roller waste collector and pull it
out.

Figure 6-32: Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly.

Figure 6-33: Removing the roller scraper screws

e
aean ™

il
- G\E;a“ e
.

Figure 6-34: Removing the old roller scraper blade

5. Remove the scraper blade and discard it.
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6. Place the new scraper blade onto the pins in the holder, as shown.

(oval hole
in blade)
=]

(round hole
in blade)
(o]

Figure 6-35: Inserting the new roller scraper blade

7. Insert and tighten the roller scraper blade screws.

Important:

* Tighten the screws in the order shown in figure 6-35.
* Use the new screws supplied in the replacement kit.

B

Figure 6-36: Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to
the print block. See steps 6 to 10, from page 6-27.

Aligning the You should check the alignment of the print heads—
Print Heads e once a month
* after replacing one or more heads

* if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see “Cleaning the Print Heads” on
page 6-18)

The head-alignment procedure takes about 20 minutes.
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To check the alignment of the print heads:
1. Prepare—
* atransparency sheet—A-4 or Letter size

* any type of sticky tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment Wizard from the Options menu (see
figure 6-22 on page 6-22).

Click Next to begin, and close the cover.

4. In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

5. When instructed to do so, place the transparency on the build tray —
next to the left and rear edges of the tray, as shown in the following

figure.

\V4%

Figure 6-37: Positioning the transparency on the build tray

6. Make sure that the transparency sheet is lying flat, and tape it to the
tray.

7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.

8. When the following screen appears, remove the transparency.

[ Head Alignment Wiza

Head Alignment Wizard

Femove transparency from tray.

[ Transparency removed.

<72 Previous

Figure 6-38: Head Alignment Wizard—steps 8-10
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6-32

10.

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

3 2 1 0 3 2 1

s LM

Figure 6-39: Sample head-alignment test

* The three columns on the right were printed by the heads used for
applying model material when producing models. From right to
left, the columns represent heads M1, M2, M3, respectively. (There
is no column for head MO0 because its alignment is used as a
reference for aligning all other heads.)

* The four columns of lines on the left were printed by the heads used
for applying support material. The columns represent heads S3, S2,
S1 and SO, respectively.

For each column of lines, use a magnifying glass or loupe to inspect
pairs of consecutive rows printed on the transparency to see where the
vertical lines align.

Alignment-line
123 4567 —numbering, left-to-right

Row pair:

Figure 6-40: Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper
and lower rows are aligned, as in figure 6-39. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head —in the next
wizard screens.

In the wizard screen shown in figure 6-37, select the Transparency
removed check box, and click Next.
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11.

12.

13.

The first in a series of alignment screens appears.

. Head Alignment Wizard

Head 6

Selectthe number representing the aligned lines
on the transparency.

’ XK Cancel ] ’{Erevious] ’ Mext = ]

Figure 6-41: Head alignment screen

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next to display the next head alignment screen, and again select
the number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen
is displayed.

. Head Alignment Wizard

Update System Parameters
Do you want to update the alignment parameters?
) Ma

@ Yes

’ XK Cancel ] ’{Erevious] [ Mext = ]

Figure 6-42: Update confirmation screen

Continue as follows:

* To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

* To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

* If you do not want to make alignment changes in the printer at this
time, select No and click Next.
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14. In the final wizard screen, choose to either repeat the head alignment
procedure or close the wizard.

* If the most closely aligned vertical lines for a print head were at
either extreme —the first or seventh lines—choose Yes to run the
Head Alignment Wizard again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

* If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

Head Alignment Wizard

Do you want to repeat the test?

@ Mo, | want to end the wizard

() *es, | want ta print anather transparency

’ XK Cancel ] ’%Erevious] [ Mext = ]

Figure 6-43: Final Head Alignment Wizard screen

Calibrating The condition of the print heads directly affects the quality of printed

Print Heads models. To maintain optimum printing, you should routinely test the print
heads, and calibrate them to the best working configuration possible. You
do this by running the Head Optimization Wizard.

If, during the optimization process, the wizard determines that a print head
is faulty —or that it is negatively affecting layer uniformity with the current
head configuration —the wizard instructs you to replace it. If this happens,
you can continue the wizard (to replace the print head) or abort the wizard
(to replace the head at another time).

negatively affecting the quality of printed models, or if you suspect that there

% Run the Head Optimization Wizard whenever the condition of print heads is
is a problem with one or more of the print heads.

Note: Allow at least three hours for performing this procedure (not
including time required for replacing faulty print heads).

To accurately test and calibrate print heads, they must be clean. If
necessary, run the Head Cleaning Wizard before beginning this procedure.

To test and calibrate the print heads:
1. Prepare—
* disposable cleaning gloves

* the scale supplied by Objet for use in the Weight Test
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Replacing the
Odor Filter

Replacing the
UV Lamps

DOC-07000 Rev. A

2. Start the Head Optimization Wizard from the Options menu of the

printer interface.

File Options Help

Go to Tray Upper Position
Go to Purge Position 16 0ct2012  19:46
Wipe

Go To Head Inspection

Purge Sequence

Pattern Test

Wizards Material Replacement
Built In Tests... CtrivAlt+B Wiper Cleaning

Head Cleaning

UV Calibration (G&R)
UV Lamp Replacement

Maintenance Counters...

Collect Service Data F2

Head Alignment

Head Optimization

Waste (gr) Load Cell Calibration
Shutdown

Ambient(°C) “ Heads Vacuum d
UV Lamps n n Pre Heater Front
Pre Heater Rear

OBJET 500

Figure 6-44: Starting the Head Optimization Wizard

3. In the opening wizard screen, click Next to begin.
The Wizard Conditions screen appears.

4. Read the conditions, select I Agree and click Next.

5. In the following screen, make sure Optimize all print heads is selected,

and click Next.

Head Optimization Wizard

Select the procedure required

@ Optimize all print heads.

() Replace faully heads and optimize all heads.

©OBJET

Figure 6-45: Procedure selection screen

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (about once a year, as necessary) to keep
your working environment pleasant. This is normally done during the

yearly preventive-maintenance service visit.

The UV lamps used for curing models have a long, but limited, working

life. The Objet service engineer tests effectiveness during regular
maintenance checks, and replaces them, if necessary. You can test and
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adjust their effective power with the UV Calibration Wizard (see “Testing
and Calibrating the UV Lamps” on page 190. If you need to replace a UV
lamp, follow these instructions:

1. Make sure the printer is in offline mode.

Figure 6-46: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

WARNING: Before continuing, make sure that the safety interlock in the
printer cover is not defeated, and that the lamp is not hot.

2. Start the UV Lamp Replacement Wizard.

* From the Options menu of the printer interface (see figure 6-33 on
page 6-27), select Wizards > UV Lamp Replacement.

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

U¥Y Lamp Replacement Wizard le

UV Lamp Replacement Wizard

Yerify that there isn't any model on the tray

? Help x Lancel | ‘% | ﬂext) |

Figure 6-47: “Empty tray” confirmation screen

The axes move to the “home” position.
4. Select the UV lamp(s) to be replaced and click Next.

U¥Y Lamp Replacement Wizard le

Select the UV lamp you wish to
replace:

[~ Right L Lamp
[ Left U Lamp

? Help x Lancel | ‘% | ﬂext) |

Figure 6-48: UV lamp selection screen
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5. Disconnect the power connection to the UV lamp.

Figure 6-49: Disconnecting the UV lamp
Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover
up (B), then out (C).

Figure 6-50: Removing the UV lamp cover

7. Pull the lamp reflector out of the print block.

Figure 6-51: Removing the UV lamp reflector
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8. Inspect the new lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the
reflector opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-up Kit. If
necessary, you can remove the black strip from the old reflector and install
it in the new reflector (as long as the black paint has not faded).

9. Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety
requirements.

10. Insert the new UV lamp/reflector unit into the housing next to the print

block.
UV lamp UV lamp
assembly— L 1 — - st  assembly

Black strip4‘ /—Black strip

Figure 6-52: Print block and UV lamp assembly, showing correct placement of
black strip

11. Replace the lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

Figure 6-53: Replacing the lamp cover
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12. Reconnect the power connection to the UV lamp.

Figure 6-54: Connecting power to the UV lamp

13. In the wizard screen, confirm that you have replaced the lamp(s) and
that the black strip is attached, then click Next.

U¥Y Lamp Replacement Wizard le

UV Lamp Replacement Wizard

[v U lamp replaced

[v Shadow bracket located corectly [zee help}

? Help x Lancel | ‘% | ﬂext) |

Figure 6-55: UV-installation confirmation screen

The wizard operates the lamps and checks if their power is within the
acceptable range for each printing mode. (The mode currently being
checked appears in the lower-left corner of the printer interface.)

UY Lamp Replacement Wizard f'5_<|

UV Lamp Replacement Wizard

Y lamp(s) warming up. This takes about 4 minutes.

00:09

C.
?

Figure 6-56: Status screen during UV lamp check

XK Cancel | <2 | s |
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14. After replacing a UV lamp, it is recommended that you calibrate its
power for the various printing modes. The final screen allows you to
continue to the UV Calibration Wizard (see “Testing and Calibrating
the UV Lamps” on page 6-190).

U¥ Replacement Wizard le

UV Replacement Wizard was
completed succesfully!

Do you want to run the 'Y Calibration ‘Wizard'
now'?

™ Mo

+ ‘ez

©OBJET

| =Z | JDonel

Figure 6-57: Final wizard screen
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Built-in Tests
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The software that runs the printer contains a suite of tests for regularly
checking the hardware and software, and for troubleshooting. You can
configure basic communications and environment tests to run
automatically, when the Objet software opens. In addition, you can run a
more comprehensive set of tests before processing a print job, as a system
check, to ensure optimum printing results.

Because running the tests effects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

* The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

g agaaaaa

Print-head heating
O Print-head filling

* A clear display of test results and the source of any failures, enabling
you to determine if printing is possible or worthwhile.

* The ability to monitor test results for specific components.
* Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you
of possible printing problems, either for current or future jobs.

Objet recommends running the built-in tests in the following cases:

* as aroutine test, once every two weeks
* as a system check, before major (long) jobs
* as needed, for troubleshooting
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From the Options menu, select Built-In Tests.
Press Ctrl+Alt+B.

Go ko Tray Upper Position FS
@ Go ko Purge Position

Wipe
Purge Sequence
Pattern Test

‘Wizards
Built Ini T

Maintenance Counters...

Collect Service Data

Built In Tests

F&
F7

Fé

F3

Chrl4+-AlE+E

Figure 6-58: Selecting Built-In Tests from the Options menu

Accessing To open the Built-in Tests screen, do one of the following:
Built-in Tests

Test Interface  The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Test Hame Group Statuz | Error Description
O 5ub-System Communicatiors Communicat... ?
O FIFO Mardnkermupt Test [rata Card ?
O FIFD Intermupt Test Drata Card ?
O Encoder Steps Count Encoder ?
O System Info Erwvironment ?
O Elack Filing Fillig ?
O Interlack. General ?
[ Catin Temperature General ?
[ Head EEFROMs Head Cards  ‘#
[ Head Yalages Head Cards ? Summary
[ Head/Block Heaters Heaters ? ]
O &=e= Limits Motars ? =
O Paramemeter Sarity Check FParameters ?
O acuum Test Wacuum ?
< | &
Tests Selection —
Group Selection Set

[ an | [ None | [Unknown| |-~ None-

v| |--N0ne -

v

Figure 6-59:Built In Tests screen
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Test List Test Name
This column lists all of the tests, together with selection check boxes.

Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group pull-down menu at the bottom of the
screen.

Group
This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
pull-down menu at the bottom of the screen.

Status

This column shows the status of each test after you run it:

& Test successfully completed.
X Test failed.

?  Unknown results. (The test has not been run yet.)

Test Selection Area In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status =?).

Group Use this menu to select tests by component category.
Selection Use this menu to select a pre-configured set of tests to run at
Set specified times (computer startup, before printing, etc.).

Running Tests To run the selected tests:

After you run a test, the Save and View command buttons are added to the
Built In Tests screen (see below).

Test Results To save and view a report of all of the tests:

» Use the Save and View command buttons (see below).
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Command Buttons  You click the command buttons, on the right side of the screen, to perform

6-44

EB' Bun
a Reset

Summary

X

"»E', Help
9% Cloze

Summary

the following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as
an HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files

are saved in the Objet installation folder, but you can save it in any other
folder.

View

Click to display the latest test report that you saved. (You can view other
test reports by opening the relevant files in your Web browser. To do so,
open Windows Explorer, and double click the BITReport file.)

Close
Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

o  All tests successfully completed.
X  Atleast one test failed.

?  Not all tests performed.
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Test Descriptions  The following table lists the name of each test in the Built-in Tests suite,
and together with its description and a possible reason for its failure. If you
Troubleshooting need assistance, contact your Objet service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between Disconnected communications cable.
Communication Eden components. Faulty cable.

FIFO Non-Interrupt/
FIFO Interrupt

Tests the data queue in the DATA
PCI card.

Faulty DATA_PCI card.

Encoder

Tests the encoder's reliability by
comparing readings from multiple
runs along the X-axis.

Faulty encoder.

System Info

Compeares the following parameter
values with the minimum
requirements.

* Physical memory
* Available memory
* Free space on disk

¢ Monitor resolution

Failure of RAM memory allocation in
the Eden computer.

Block Filling

Analyzes the thermistor readings
when the block is full and when it is

empty.

Faulty thermistor.

Interlock

Tests the interlock in the printer
cover.

Failure of interlock mechanism.
Faulty latch.
Disconnected cables.

Cabin Temperature

Tests the temperature level in the
build-tray area.

Faulty temperature sensor (OHDB).

limits of all axes.

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card.
the print-head driver cards.

Head Voltage Checks the control of voltages Faulty print-head driver card.
supplied to the print heads.

Tray Heater Not used for this printer —

Head/Block Heaters | Tests the heaters in the print heads | Faulty heaters or thermistors.
and in the print-block body.

Axes Limit Tests the hardware and software Faulty hardware sensors.

Wrong Max Position parameter.

Parameter Sanity
Check

Compares the values of all printer
parameters (in cfg files) to the
required values.

One or more of the printer parameters
is not within the required range. You
can view details in the BIT report.

Vacuum

Tests the vacuum level in the print
block.

Faulty vacuum sensor.
Vacuum leakage.
Wrong parameters.
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Replacing the  The waste container contains partially cured polymeric material produced

Waste during normal operation and maintenance of the printer. For safety and

Container environmental reasons, this material is kept in a special leak-proof,
disposable container.

The container has a capacity of 10 kilograms of waste material —usually
enough for several months of printer use. The printer software displays a
warning message when there is 9 kilograms of material in the container,
and stops the printing when the net weight reaches 9.5 kilograms. Above 9
kilograms, the software does not allow you to start a print job (or a printing
activity) until you replace the waste container. You can monitor the weight
of the waste container in the Maintenance screen of the printer interface. You
can also visually inspect the level of waste in the container. (To access it, see
page 6-237.)

To monitor the waste weight (and other indicators) in the printer:

> In the main printer interface screen, click the display toggle to view the
printer indicators.

mET 16 Oct 2012 19:14

Heads (°C)

| 65 | 65 BER 65 |l 65 § 65 | 65 | 65 || 65 NT

Waste weight— Waste (nr) 9000 Heads Liquid
Ambient(°C) “ Heads Vacuum

UV Lamps n n Pre Heater Front g;gllg){)utton
/

Pre Heater Rear

—a® OBJET 500

Figure 6-60: Printer interface, showing waste weight (red background indicates
operator alert)

The waste container consists of a plastic container inside a cardboard box.
You typically dispose of the entire waste container —including the box.
Therefore, you must assemble a new box and insert a new plastic container
before you can install it in the printer.

Replacement boxes, plastic containers, and sealing caps are supplied in the
Objet printer start-up kit and in the preventive-maintenance Kkit.
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To prepare a new waste container:

1.

Assemble the cardboard box, making sure to punch out the perforated
sections.

Place a new plastic container into the box.

Note: Do not close the box until you connect the waste drain tube from the
printer (see below).

To replace the waste container:

Locate the door on the lower-left side of the printer.Push in the upper-
right corner of the door to release the latch and open the

door. L B ey L
Figure 6-61: Accessing the waste container

3. Carefully slide out the waste container to remove it from the printer.

Figure 6-62: Removing the waste container

Place the new waste container next to the full container.

Unscrew the cap securing the waste drain tube and connect it to the
new container.

Close the full container with a sealing cap.
Close the new waste-container box, using tape to hold it closed.
Position the waste container under the printer, on the load cells.

* The container should be on the extreme right side of the
compartment.

* Make sure that the waste drain tube is not crimped and that it is not
pinched by the container.
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9. Close the waste compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.

Cleaning the The painted exterior plastic panels of Objet 3-D printers have a durable

Exterior Panels finish, offering excellent chemical resistance to common cleaning agents.
However, follow the recommendations below when cleaning these areas of
the printer.

Acceptable Cleaning Agents

* mild soap solution

¢ common household cleaners and window cleaners

* common commercial and industrial detergents, 5% solution in water
* alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials
* industrial solvents

* cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

* spray disinfectants

* abrasives and agents which could wear away the panel finish
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Handling Printed Models

Removing Models After Printing
Removing the Support Material..
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Handling Printed Models

Removing Models After Printing

N

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the printer, it is best to let the printed models cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional models as soon as
possible:

1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or
spatula (supplied in the tool kit), taking care not to pry or bend the
model.

WARNING: Wear protective gloves when handling printed models
before they are washed.

3. DPlace the models on a flat surface, and cover them with a cardboard
box or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support Material with Water Pressure

For most models, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Balco Water]Jet
cleaning unit, shown in figure 7-1 on page 7-3. This device is marketed by
Objet.
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Figure 7-1: Balco WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump
turns ordinary tap water into a high-pressure jet, and a wiper keeps the
window clear.

Use caution when cleaning delicate models with high-pressure water
systems.

Removing Support Material with Caustic Soda

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half-an-hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly

(with a water jet) afterwards.

blindness. Mixing it with water generates heat that could ignite other
materials.Take adequate safety precautions; always use nitrile gloves
when handling caustic soda and models soaked in it.

2 WARNING: Caustic soda may cause chemical burns, scarring and
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Post-Printing Treatment for Models Printed with Objet VeroClear

Photo-
Bleaching
Instructions

W=

Models made with Objet VeroClear have a slight yellow tint when removed
from the printer. This is especially true for models printed with a glossy
finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As a rule, best clarity is achieved when parts are printed with a matte
finish, and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.
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Figure 7-2: Figure 7-3:

Follow these instructions for photobleaching printed models.
® The fluorescent lamps should be rated 45W, 6500K.

® When using desk lamps, place the models in a container covered with
aluminum foil. Use at least two lamps, more when treating models in a
large container.

® Arrange the models with enough space between them to allow light to
reach all sides of each model.

® Verify that the ambient temperature around the models is
approximately 40°C (104°F). Higher temperatures may cause model
distortion; lower temperatures may not produce satisfactory results.
When using desk lamps, you can achieve the required temperature by
positioning the lamps approximately 10 cm (4 in.) above the models.

® Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching
treatment for up to 18 hours more.

In Objet laboratories, there was a tint reduction of approximately 70%
within six hours. After 24 hours, tint was reduced by approximately
90%.

For more information about this treatment, see the application note
“Objet VeroClear for Desktop Pro Printers” (DOC-24131).
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Storing Models

Models are cured as they are printed, making them safe and stable for a
long time. However, proper storage conditions are necessary to prevent
deforming.

® Keep printed models at room temperature and in a low-humidity
environment.

® Do not expose models to direct sunlight and other heat sources.
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Handling Printed Models
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